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*% detected as AI
AI detection includes the possibility of false positives. Although some text in 
this submission is likely AI generated, scores below the 20% threshold are not 
surfaced because they have a higher likelihood of false positives.

Caution: Review required.

It is essential to understand the limitations of AI detection before making decisions 
about a student’s work. We encourage you to learn more about Turnitin’s AI detection 
capabilities before using the tool.

Disclaimer
Our AI writing assessment is designed to help educators identify text that might be prepared by a generative AI tool. Our AI writing assessment may not always be accurate (i.e., our AI models 
may produce either false positive results or false negative results), so it should not be used as the sole basis for adverse actions against a student. It takes further scrutiny and human 
judgment in conjunction with an organization's application of its specific academic policies to determine whether any academic misconduct has occurred.

Frequently Asked Questions

How should I interpret Turnitin's AI writing percentage and false positives?
The percentage shown in the AI writing report is the amount of qualifying text within the submission that Turnitin’s AI writing 
detection model determines was either likely AI-generated text from a large-language model or likely AI-generated text that was 
likely revised using an AI paraphrase tool or word spinner.
 
False positives (incorrectly flagging human-written text as AI-generated) are a possibility in AI models.
 
AI detection scores under 20%, which we do not surface in new reports, have a higher likelihood of false positives. To reduce the 
likelihood of misinterpretation, no score or highlights are attributed and are indicated with an asterisk in the report (*%).
 
The AI writing percentage should not be the sole basis to determine whether misconduct has occurred. The reviewer/instructor 
should use the percentage as a means to start a formative conversation with their student and/or use it to examine the submitted 
assignment in accordance with their school's policies.

What does 'qualifying text' mean?
Our model only processes qualifying text in the form of long-form writing. Long-form writing means individual sentences contained in paragraphs that make up a 
longer piece of written work, such as an essay, a dissertation, or an article, etc. Qualifying text that has been determined to be likely AI-generated will be 
highlighted in cyan in the submission, and likely AI-generated and then likely AI-paraphrased will be highlighted purple.
 
Non-qualifying text, such as bullet points, annotated bibliographies, etc., will not be processed and can create disparity between the submission highlights and the 
percentage shown.
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Unit 1: Introduction to Power BI 

 

 

Learning Outcomes 

 

1. Understand the key concepts of Business Intelligence (BI) and its role in data-
driven decision- making. 

2. Identify the core features and advantages of using Power BI for modern business 
analytics. 

3. Explore the components of the Power BI ecosystem, including its architecture 
and integration capabilities. 

4. Demonstrate the ability to install and configure Power BI Desktop for personal 
and organizational use. 

5. Recognize the various data sources supported by Power BI and understand how 
to connect to them. 

6. Apply basic Power BI functions to create visual dashboards and generate 
actionable insights. 

7. Evaluate real-world BI applications through case studies, key term reviews, and 
descriptive questions. 

 

 

 

Content 

 

1.0 Introductory Caselet 

1.1 Overview of Business Intelligence and Analytics 

1.2 Introduction to Power BI: Features and Benefits 

1.3 Power BI Ecosystem 

1.4 Installing and Setting Up Power BI Desktop 

1.5 Summary 
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1.6 Key Terms 

1.7 Descriptive Questions 

1.8 References 

1.9 Case Study 

  

1.0 Introductory Caselet 

 

“The Sales Manager’s Dilemma: Data Everywhere, Insights Nowhere” 

 

Background: 

Priya is a regional sales manager at a fast-growing FMCG; she attends the monthly 
review meeting along with her team. Though she puts in long hours and gathers stacks 

of spreadsheets from the field agents, she has a hard time responding to a fundamental 
inquiry from her director: 

“What was the quarter’s best-performing product line for us, and in which region?” 

The data is there — but stored across emails, Excel files, shared drives and legacy 
systems. It occurs to Priya that even though the team is utterly overwhelmed with raw 
data, it has no means of transforming that data into valuable insights. 

A few days later, an IT consultant gives the management team a presentation on 
Business Intelligence (BI) tools and Power BI. Within minutes, dashboards show 
trends, low-selling SKUs and sales forecasts that would have taken days to tally up with 
pen and paper. 

Dismayed by the speed and clarity of information they received, Priya’s only comment 
was: “Why didn’t we do this earlier?” 

The road of data driven decision making has just begun. 

Critical Thinking Question: 

What risks do companies expose themselves to by sticking to manual, fragmented data 
processing in the digital age vs using Business intelligence tools? 

 

1.1 Overview of Business Intelligence and Analytics 
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Business Intelligence (BI) is a set of strategies, processes and technologies that 
businesses leverage to collect data that help in decision-making. The point is 
straightforward, yet profound: to help make better decisions. 

BI takes raw data and turns it into useful insights using applications that enable users 
to see trends, patterns, and anticipate future outcomes. It's the connective tissue 

between where data lives (databases, spreadsheets, warehouses) and the meaningful 
tools people use to make business decisions. 

Key Components of BI: 

• Data Preparation: Pooling together data from disparate internal and external sources. 

• Data Integrations: Cleaning and merging data from various systems to make them 
consistent. 

• Analysis of Data: Using statistical and logical methods to interpret the data. 

• Data Visualization: Utilizing charts, graphs and dashboards to display results. 

What is Business Analytics? 

Where BI is about reporting and monitoring, Business Analytics (BA) is forward looking. 
It uses 

predictive and prescriptive analysis to address questions such as: 

• What will happen? (Forecasting) 

• What should we do? (Optimization) 

BI and BA are just one aspect of the larger world of data-based decision making. BI is 
getting intel of what has happened while BA is something that can help you predict the 
next occurrence. 

Importance in Modern Business: 

• Faster, more informed decisions 

• Reduced manual reporting errors 

• Enhanced competitive advantage 

• Ability to recognize new business opportunities 

• Alignment of departments with common metrics 

In a world where data is the new oil, BI is the refining process that convert raw data into 
valuable insights. 
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1.1.1 Concept of Business Intelligence (BI) 

Business Intelligence (BI) [3] is a term that encompasses the concepts, methods and 
tools used in research of business information to support decision making. The aim is to 
foster more informed decision-making for all employees. 

And such BI systems turn raw data into useful information by enabling organizations to 
answer key questions, including: 

• What happened? 

• Why did it happen? 

• What is happening now? 

• What might happen next? Key features of BI include: 

• Dashboards that display key indicators on a single page 

• Reports for tracking performance 

• Data visualization to identify trends and patterns 

• The ability to drill down into secondary and tertiary layers of data 

Business intelligence systems are frequently implemented over disparate sources like 
ERP, CRMs spreadsheets or databases oƯering one holistic view of operations. 

 

1.1.2 Role of Analytics in Business Decision-Making 

Where BI sets the groundwork, analytics adds depth. Analytics uses mathematical, 
statistical, and computational methods to analyze data and inform decision making. 

There are four primary varieties of analytics: 

Descriptive Analytics – What has happened? (e.g., last quarter’s sales) 

Diagnostic Analytics – What happened? (for example, explanation for the reduction in 
the sales) 

Predictive Analytics – What is going to happen? (e.g., forecasting demand) 

Prescriptive Analytics- What ought we do? (e.g., resource allocation) In business, 
analytics is used for: 

• Enhance eƯiciency in operations 

• Minimise risk by prediction of future situations 

• Improve customer experiences through personalization 
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• Maximize marketing, inventory, staƯing etc. spend and ROI. 

Analytics makes insights actionable, and keeps businesses competitive amidst oceans 
of data. 

 

1.1.3 Evolution: From "Traditional BI" to Self-Service BI 

1 Legacy BI was mostly IT-driven That is to say, business users would go begging to the 
tech team for data reports, often with long waiting times and little room for flexibility. 

Now that we have Self-Service BI: Business users can: 

• Connect to data sources directly 

• Develop reports and dashboards from the "ground up." 

• Ask 'freeform' questions with no code required 

• Real-time data access Major DiƯerences: 

 

Feature Traditional BI Self-Service BI 

User Control IT-centric Business-user centric 

Report Creation Time Slow and formal Fast and interactive 

Flexibility Limited High 

Tools Example Cognos, MicroStrategy Power BI, Tableau, Qlik 

 

This shift empowers decision-makers to be more agile, data-literate, and responsive 
in dynamic business environments. 

 

Did You Know? 

“Do you realize that in the old BI world users had to wait two- three days or weeks for 
their IT departments to generate them reports? On the other hand, self-service BI tools 
such as Power BI enable business users to create dashboards on-the-fly to slash the 
reporting cycles down by more than 80% across numerous organizations. This isn’t just 
a shift in technology: This is making data available to all, and allowing non-technical 
users to make the decisions they need with hard information without developers getting 
involved. 

1.1.4 Applications of BI Across Industries 

BI use is prevalent in nearly every industry. Some notable applications include: 
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• Retail: Customer Segmentation, Inventory Management, Sales Forecasting 

• Healthcare: Patient data analysis, operations streamlining, fraud prevention 

• Banking & Finance: Risk assessment, compliance monitoring, credit scoring 

• Manufacturing: Supply chain performance, quality assurance 

• Education – Student Performance Monitoring/Institutional Budgets 

• Logistics - Route optimization/delivery tracking/cost analysis etc. 

• Guest preference tracking, occupancy forecasting and Hospitality 

In all industries, Business Intelligence (BI) allows companies to turn data into 
information, which in turn can be converted into decisions that create a competitive 
advantage and even smarter business operations. 

1.2 Introduction to Power BI: Features and Benefits 

Power BI is a Business Intelligence software developed by Microsoft. It enables users 
to link to data, visualize it and share findings throughout the organization. Power BI 
processes raw data into pristine, human-readable and interactive reports and 
dashboards that empower people to make informed decisions. 

It's popular with analysts, business users and decision makers alike because it has a 
more friendly end user interface (UI), integrates easily with Microsoft products, and has 
robust data visualization out of the box. 

1.2.1 What is Power BI? 

Power BI Power BI is a cloud-based data analytics service that allows users to: 

• Connect to data from multiple sources (Excel, SQL databases, cloud platforms etc.) 

• Clean and transform the data 

• Create interactive reports and dashboards 

• Share these news articles with others on web and mobile platforms It has several 
features: 

• Power BI Desktop (your own computer – The tool to create reports on your personal 
computer 

• Power BI Service – A service online to publish, share and collaborate with the reports 

• Power BI Mobile – Mobile report apps to explore reports and dashboards on the go 

• Power BI Gateway – Connect to cloud data sources, directly on-premises data 
sources and have machine generated data in the cloud. 
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• Power BI Embedded – Lets developers embed reports in their own applications 

Power BI is well-liked because it puts everything – data modeling, visualization and 
collaboration tools – in one place. 

1.2.2 Key Features of Power BI (Dashboards, Reports, Visuals) 

Below are key features that make Power BI a great business intelligence (BI) tool: 

Dashboards 

o A dashboard includes multiple visualizations on a single page, giving you an at-a-
glance overview of your data. 

o It is great for monitoring KPIs, performance metrics and business trends. 

o Dashboards _You can create dashboards by combining reports from one, or more 
viewpoints and then share them with others online. 

Reports 

o A report is a multi-page document containing visuals, filters, and slicers. 

o Each page is based on diƯerent data (sales, regions, customers) 

o Power BI Desktop is used to author reports, then publish them on Power BI Service. 

Visualizations 

Power BI includes a large number of built-in visuals: bar charts, pie charts, maps, 
tables, gauges and scatterplots among others. 

o Users can also download custom visuals. from Power BI marketplace! 

o These pictures are interactive, i.e. it is possible to click and select, filter and drill. 

Data Connectivity 

o Power BI integrates with many data sources: Excel, SQL Server, SharePoint, Google 
Analytics, Azure and Salesforce just to mention a few. 

Data Modeling and DAX 

o Power BI – capability to model data including relationship, measures and calculated 
columns. 

o It utilizes DAX to manage complex calculations and aggregations. 

Filters and Slicers 

o Data can filter across visuals by using slicers or filters to focus on specific views. 

Natural Language Query (Q&A) 
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o You can type in questions in English like “show me sales by region” and Power BI will 
answer with the appropriate visual. 

Did You Know? 

Did you know that with Power BI you can create a custom visual using Javascipt and 
D3? js library? Most people use the default ones (like bar graphs or pie charts), but you 
can create entirely new types of visuals that match your exact business needs—
whether it’s radar charts, bullet graphs or animated visuals. The stock’s creator 
Solomon Rutzky explained: “These custom visuals can be brought into Power BI via the 
Visuals Marketplace.” 

1.2.3 Benefits of Power BI for Organizations and Users 

What is Power BI? there are many benefits of using Power BI - for both users and 
organizations: 

• Ease of Use 

o Microsoft’s business intelligence software has an intuitive interface and is simple to 
learn and. 

• Cost-EƯective 

o Ideal for small to big businesses, Power BI can be obtained in the free desktop 
version and budget-friendly subscription services. 

• Real-Time Insights 

o With Power BI, get real-time data updates and live dashboards on the go to know your 
business performance as-it-happens. 

• Improved Decision-Making 

o Simple visual interface which helps the stakeholders analyze data faster and take 
more informed decisions. 

• Data Integration 

o Power BI has the ability to integrate data from many places, so one can have a unified 
perspective of their business. 

• Collaboration and Sharing 

o Reports can be shared securely with others in the organisation or outside. 

• Scalability 

o Power BI scales from small data to very large with ease. 

• Cloud-Based Access 
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o Both reporting and dashboards are accessible remotely through the cloud or mobile 
applications. 

Action: Assess Business Value of Power BI Dashboards 

Instruction to Student: 

You are interning in BI domain in a retail company. Your boss would like to assess how 
Power BI can help streamline decision making. Consuming the “Retail Analysis 
Sample” dataset (Included in a built-in samples of Power BI): 

Connect to the dataset from Power BI Desktop. 

Create a dashboard showing: 

o Total sales by region 

o Category-wise profit margin 

o Day by day pattern of sales in the last quarter 

Composition Write a brief (150–200 word) commentary in response to the following 
question: 

o What has the use of a dashboard brought to your company that Excel sheets have 
not? 

o For what type of daily decisions mamanger of the given granularity (regional manager) 
can use this dashboard? 

Submit the screenshot or.submit the dashboard. pbix file) and the report of what I did. 

1.0.1 Comparison of Power BI with Other BI Tools 
 

Power BI is one of several BI tools available in the market. Here's how it compares with some other 

popular tools: 
 

Feature Power BI Tableau Qlik Sense 

Developer Microsoft Salesforce (Tableau) Qlik 

Learning Curve Easy for Excel users Moderate Moderate 

Data Modeling Strong (DAX, Power Query) Good Good 

Visualization Excellent Excellent Good 

Cost Affordable Higher Varies 

Cloud Support Strong Strong Moderate 

Integration with Microsoft tools Excellent Limited Limited 

Natural Language Query Yes (Q&A feature) Limited No 
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Power BI stands out for its integration with the Microsoft ecosystem, strong data 

modeling, and cost- eƯectiveness, making it a top choice for many organizations, 

especially those already using Microsoft 365 tools. 

1.3 Power BI Ecosystem 

What is the Power BI ecosystem? The Power BI ecosystem consists of many tools and 
platforms which are designed to integrate well with each other for easy data analysis, 
visualisation, sharing, and accessibility. It is built to accommodate a range of user 
levels, including analysts, business users, and decision-makers, working from their 
desktops or in the cloud or on mobile devices. 

The ecosystem mainly consists of: 

• Power BI Desktop 

• Power BI Service (Cloud) 

• Power BI Mobile 

• Utilities that support harmonization of this platforms into an unified pipeline. 

1.3.1 Power BI Desktop: Features and Implementations 

Power BI Desktop is a Windows desktop application that can be used to build data 
models, create reports and visualizations and read/rest during those long running DAX 
measures. 

Capabilities: 

• Connect to data sources from diƯerent places (Excel, SQL Server, Web and 
SharePoint sites) 

• Data cleaning, and transformation with Power Query Editor 

• Relationships, hierarchies, and calculated fields for Data Modeling 

• Visualization construction: drill throughs, KPIs and maps tables/ charts/ graphs. 

• Custom measures and calculations (DAX formulas) 

• Drill-down and filters to explore the data in details 

Use Cases: 

• Generating reports for sales, finance, operations etc. 

• Data dashboards for use in team or management meetings 

• Monitoring trends, outliers and business patterns in data 
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• Creating models for predictive or comparative analytics 

The Power BI Desktop is where most of the development work gets done before 

publishing to the cloud. 

1.3.2 Power BI Service - Cloud Collaboration and Sharing 

The cloud-based half of the ecosystem is the Power BI Service. It enables users to 
share, and publish.contributepublish. 

work on reports and dashboards that have been developed in Power BI Desktop. 

Capabilities: 

• Sync and publish from Desktop files to the cloud 

• Build dashboard with the ‘pin to dashboard’ capability pulling visual from multiple 
reports 

• Schedule data refresh to ensure your reports are up to date 

• Work together by sharing reports with teams or stakeholders 

• Manage report development and access in teams using Workspaces 

• Configure row-level security (RLS) to determine which data is visible to whom. 

• Access Power BI Apps – an integrated collection of apps, dashboards, and reports 

Benefits: 

• Organization-wide access to insights in one place 

• Easy, secure sharing without large files to email 

• Live dashboards, which updates data in real time 

• Includes notifications, subscriptions and interactive Q&A 

As an enterprise, team collaboration using Power BI Service is a must. 

1.3.3 Just the ticket – Power BI Mobile on the move 

Power BI Mobile contains a set of native apps for iOS, Android and Windows 10 devices 
where users can view, interact with, and share reports and dashboards while on the go. 

Features: 

• View published reports and dashboards from anywhere, at any time 

• Get push notifications for alerts and changes 

• Use touch-enabled filtering and drill-downs 
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• Scan QR codes to view reports on physical assets or locations 

• Mobile support on layouts for better visibility 

Use Cases: 

• Executives tracking KPIs during travel 

• Sales organizations evaluating in-person performance 

• Operations managers watching live data from the shop floor 

• Threshold based alert on performance for real-time decision making 

Power BI Mobile ensures that you can make decisions on the go and in real time 

to critical insights. 

1.3.4 Desktop Services and Mobile Integration 

The greatness of Power BI is how all its parts come together to create an ecosystem. 
Workflow Integration: 

Create a report with Power BI Desktop 

Publish the to Power BI Service 

Access the report: Power BI Mobile Integration Benefits: 

• Smooth transition from development to sharing 

• Consistent access across devices 

• Cloud-based backups and version control 

• Shared dashboards for team collaboration 

• One truth for the whole organization 

This interoperability fosters a flexible, agile BI environment in which users are able to 
work across platforms while maintaining consistency of data, access and use. It also 
helps to ensure that insights are shared across devices and teams, facilitating 
decision-making at every level of an organization. 

Did You Know? 

What you now can say though is, once I publish a Power BI report from Desktop to the 
Cloud Service did you know that you could pin an item on your dashboard and then 
subsequently embed it within another website or application by using Power BI 
Embedded. It’s a mechanism tech companies use when they expose analytics into 
customer facing portals—especially if users don’t even realise they are looking at Power 
BI report.” 
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1.4 Installing and Setting Up Power BI Desktop 

Power BI Desktop is a Windows desktop application free to download and use that you 
can use to build data models, create reports and dashboards. This section covers 
installing the software, getting around in it, hooking up to sample data, and making 
some initial settings. It is the starting of a journey to leverage Power BI eƯectively. 

1.4.1 System Requirements and Installation Steps  

Before you start Power BI Desktop installation, be aware that your computer system 
should have: 

• OS: Windows 10/11, or Windows Server (64bit) 

• Memory: 4 GB RAM (8 GB recommended for using large datasets) 

• Disk Space: Approximately 2 GB free space for installation 

• . NET Framework : 4.7.2 or above 

• Processor: 1 gigahertz (GHz) or faster, compatible with 64-bit processes 

There is no Power BI Desktop for macOS or Linux. Mac users generally access it 
through virtualization software. 

Installation Steps 

Go to the Power BI download page. 

Click "Download free," and then select the Microsoft Store or Direct Installer version. 

Download and install Power BI Desktop as directed. 

Once installed, open the app and sign in with a Microsoft account (not required but 
recommended for publishing to the cloud). 

Once it is installed, you’re ready to explore and report build. 

 

1.4.2 Navigating the Power BI Desktop Interface 

There are a few key parts of the Power BI Desktop interface: 

• Ribbon (Top): Just as is the case with Excel or Word, the ribbon display at top includes 
Home, Modeling, Insert and View tabs lined with commands. 

• Canvas (Center) : This is where charts ,tables, visuals are displayed. 

• Fields Pane (Right): All tables and fields from connected data sources are listed. 
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• Visualizations Pane (Right): House of a variety of charts and visuals (eg bar, line, pie, 
map). 

• Filters Pane (right): You can add filters that apply to the whole page, visual or field. 

• Tabs (Bottom): Think of them as diƯerent report pages - like sheets in Excel. 

Knowing the layout is essential for an eƯective report creation. You can also drag and 
drop fields into the canvas to build visuals. 

1.4.3 Connecting Power BI and Sample Data 

To start using Power BI, you must connect it to your data. 

Instructions to Connect to sample data: 

On the home tab, click “Get Data”. 

Select a source of your data (for example, Excel, CSV, Web, SQL Server). 

Navigate to and choose a file (e.g., sample Excel workbook). 

Preview the tables, and then select which of the tables you want to import. 

Click Load to load the data into Power BI. 

After the data loads, it's displayed in the Fields pane where you can start dragging 
fields to create visuals. 

Meanwhile, Microsoft provides built-in example datasets like “Retail Analysis Sample” 
and “Financial Sample,” which are helpful for visualization beginners to train 
themselves with. 

“Task: Practicing Data Connection and Transformation” 

Instruction to Student: 

Download a publicly accessible CSV file (such as “Global Superstore Orders”) from 
Kaggle or a government data site. 

Open Power BI Desktop and connect to the CSV file. 

Open Power Query Editor and do the following: 

o Delete empty three rows and unnecessary columns o Resize rows using the row 
height tool under format o Add space after column titles by increasing font size, then 
undo-ctrl z (do this until you are happy with spacing) o Delete all pulled information. 

o Rename columns appropriately 

o Convert order date to date o Get distinct order type, and take whole list / output 
invitation for 2nd iteration as well. 
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o Create a Year column using the date of order as reference 

Load the washed data into Power BI and create a basic table visual which displays 

Total Sales by Year. 

Submit: The cleaned dataset (Image) and the final visual (Screenshot) 

1.4.4 Basic Settings and Initial Configuration 

When you have Power BI Desktop and data connected, check out some key settings to 
follow: 

Auto Save and File Format 

• Save your work via File → Save As …. 

• Power BI saves files in. pbix format. 

Data Refresh 

• If you're connected to live source data (such as a database or the web), refresh 
options can be configured under Home → Refresh. 

• You can specify scheduled refresh as part of publishing to Power BI Service. 

Theme and Layout 

• Select a report theme under View → Themes. 

•This helps maintain consistent colors and formatting across graphics. 

Data Relationships 

• Relationships between tables are detected automatically in Power BI. 

• You can view and control them under Model by adding or removing relationships. 

Privacy Settings 

• Change privacy settings located at File → Options → Global → Privacy to specify the way 
your data sources are communicating with other people. 

These starting configurations will prepare your Power BI Desktop for eƯicient and secure 
data analysis. 

Knowledge Check 1 

Choose the correct option: 

Which of the following statement best expresses the primary objective of Business 
Intelligence? 

A) To store huge amounts of data in a safe place 
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B) To gather, process and provide information for decision-making 

C)To design software for use with mobile's devices 

D) To automate the process of human decision making 

Which of the following is not a part of Power BI ecosystem? 

A) Power BI Desktop 

B) Power BI Service 

C) Power BI Mobile 

D) PowerPoint BI 

What is the role of Power Query Editor in Power BI? 

A) To visualize charts and graphs 

B) To write complex DAX formulas 

C) To prepare and modify the data before bringing it into the data model 

D) All of the above + To send reports to non AAD members. 

Which capability of Power BI enables users to design one-page visual overviews of 
business performance? 

A) Dataflow 

B) Dashboard 

C) Report 

D) Dataset 

Which of the below is an advantage of Self-service BI tools like Power BI? 

A) Reports can only be created by IT personnel 

Key points regarding data access: a) Only senior managers have access to the data. 

C) Users will be able to easily build their own reports and dashboards without having to 
rely on programming 

D) Reports are never available on line only except in hard copy format 

 

1.5 Summary 

 In the module, we started with an introduction to basic concept in BI and a general 
view of Power Bi as a modern BI tool. To start, we explored what BI is and why an 
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organization might be interesting in pursuing it, as well as the role that analytics plays 
in facilitating various types of business insights: descriptive to prescriptive. 

The mo du le the n introduced P o we r BIâ€™s func tionalities and advantages, its 
ecosystem (Desktop, Service and Mo- bile) an d ho w they interact toget her to enable 
data analysis/s har ing by providing: • Data Prep aration; • Infor mati on Di‡ usi on [3]: 
shared digital co ntent that is limited in scope in tim e/spac e/pe rspective,among users 
in orde r to achieve a co mmon unde rstang. Lastly, it detailed the installation and 

configuration of Power BI Desktop - requirements, interface, data connections, and 
simple settings. 

By the end of this unit, learners should feel comfortable with BI concepts and have a 
good concept what it takes to get started using Power BI for data analysis. 

 

1.6 Key Terms 

Business intelligence (BI) – The technologies that support an information delivery and 
analysis, enabling access to data for the purpose transferring knowledge into insight. 

Analytics – The process of eƯicient and methodical data extraction to discover 
patterns, trends and insights in the data that enable decision making. 

Power BI - A Microsoft business intelligence product that provides a way to connect 
data sources, prepare reports and visualizations, and share insights throughout an 
organization. 

Dashboard: A Power BI visual interface which shows key metrics and data visuals on 
one screen, typically used for business reporting. 

Data Model - A part of Power BI in which data tables and their relationships are 
established for analysis and reporting. 

DAX (Data Analysis Expressions) – DAX is the formula language used in Power BI 
creating custom calculations and expressions that are used within reports and 
dashboards. 

Power BI Desktop – A free and downloadable Windows application that enables you to 
build reports, create visuals, and model data. 

Power BI Service – The online environment to which you publish, share, and collaborate 
with your Power BI reports and dashboards. 

Power BI Mobile – The mobile app of Power BI, enabling users to visualize reports and 
dashboards on their mobile devices. 
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Self-Service BI – A function that enables the end-user to probe data and produce their 
own reports and dashboards, without needing technical assistance or waiting for an IT 
department to do it. 

1.7 Descriptive Questions 

Define Business Intelligence. How is it distinct from Business Analytics? 

Describe three features of Power BI. 

Explain the function of Power BI Desktop, Service and Mobile within Power BI 
ecosystem. 

Why use Power BI for business reporting? 

Describe the process for installing Power BI Desktop and connecting to an Excel file 
with sample data. 

Evaluate Power BI against an alternative BI solution you are familiar with in terms of 
interface and cost. 

Describe the significance of self-service BI and how Power BI facilitates it. 

1.8 References 

1. Microsoft Power BI Documentation: https://docs.microsoft.com/en-us/power-bi/ 

2. Ramesh, S. (2020). Business Intelligence Demystified. TechPress. 

3. Kimball, R. & Ross, M. (2013). The Data Warehouse Toolkit. Wiley. 

4. Choudhury, A. (2021). Power BI for Beginners. DataSense Publications. 

5. Tableau vs Power BI Comparison. Gartner Magic Quadrant Reports. 

Answers to Knowledge Check 

Knowledge Check 1 

B) To gather, study, and report information in support of decision-making 

D) PowerPoint BI 

C) Data cleaning and transformation before loading into data model 

B) Dashboard 

C) They should be able to report and visualize themselves without programming. 

1.9 Case Study 

Power BI Shopping Insights: A new way to track the performance of your shopping 

malls and retail stores! 
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Introduction 

The retail industry today, data is being created at every touch point of sale, to inventory, 
through marketing campaigns and customer service and more. But for most SMBs, this 
data is untapped because of disconnected systems and manual reporting. 

RetailX RetailX, a medium-sized fashion retail chain with a presence in five cities, was 
struggling to get timely visibility into store-level performance. Scatter and Pie-Chart 
charts The regional managers were reporting from Excel-based reports that were put 
together manually by aggregating across the branches, resulting in legacy data errors 
and missed opportunities. 

The organization chose to investigate Power BI – a self-service business analytics 
solution - for data consolidation and visualization. Two months later and RetailX moved 
from static reports to dynamic dashboards with everything being accounted for in real 
time so the right decisions could be made at every level. 

This caselet examines some of the core issues that RetailX faced, how they turned to 
Power BI for solutions and what impact it had on their business. 

Background 

RetailX used to work on conventional reporting, where the branch managers would send 
weekly Excelsheets to head oƯice. The analytic team then aggregated these reports. 
This manual approach resulted in: 

• Redundant forms of data between branches 

• The lagging nature of the reporting (4–5 days in many cases) 

• Unable to predict real-time sales trends 

• Cross-regional performance comparisons can be challenging 

The leadership of RetailX sought a cloud-based, user-friendly and visually appealing 

solution. They did not select Power BI after investigating several options due to 
considerations around its ability to connect with Excel, strong data modeling 
capabilities, and simple dashboard building. 

Problem 1: Broken and Manual Reporting process 

The process that RetailX had for their report generation was slow and error-prone, 
hence the team could not always respond to business trends which have fast 
consequences. 

Solution: Power BI Desktop was installed on each site to ingest, transform and model 
local sales and inventory data. These files were uploaded to Power BI Service, and 
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regional managers and c-level executives had access to centralized dashboards. 
Scheduled data refresh has been automated, as well. 

MCQ 1 

What was the main advantage of RetailX migrating its reports to Power BI? 

A) Reduced hardware costs 

B) Facilitated real-time, automated and consolidated reporting 

C) Gave managers the leverage not to report at all 

D) Increased manual data entry eƯiciency 

Correct answer: B) Allowed for automated, centralized and real-time reporting 

Note: Thanks to Power BI, RetailX transitioned from manual spreadsheets to real-time 
dashboards that refreshed automatically, enhancing decision making and avoiding 
delays. 

Issue 2: No Visibility into Store results at the store level 

There was no graphic summary for the leadership group that showed how each store 
was doing in sales, profit margin and retaining customers. 

Resolution: Dashboards with region and product category filters, trend graphs and 
KPIs, were implemented. This made it easy to quickly spot under-performing branches 
and high- demand product categories. 

MCQ 2 

What Power BI capability enabled RetailX to analyze performance between its stores? 

A) File compression 

B) Natural Language Queries 

C) Interactive dashboard having filters and visuals 

D) Advanced coding scripts 

Answer: C) Interactive dashboards with filters and graphical presentations 

Explanation: Dashboards enabled the management to filter data, based on their 
location where they were working at - product category, time frame, (range) 
performance comparison easy and fast. 

Problem 3: Lack of Communication between Sales and Inventory Dieties 

Sales teams had no visibility of available stock real time due to disconnected systems, 
and thus over-promised or lost sales. 
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Solution: Having incorporated inventory information into the Power BI model, sales 
reports now also included live stock levels. Conditional formatting and Power Automate 
email notifications have been used to provide alerts on when the stock is getting low. 

MCQ 3 

How did Power BI help coordinate sales and inventory divisions? 

A) By limiting the access of sales details 

B) Live updates of the inventory availability on the dashboard(s). 

C) They build individual dashboards for each team that don’t overlap 

D) By disabling dashboard filters 

Answer: B) Through the use of dashboards with live inventory updates 

Explanation: The real-time stock data on the sales dashboard helped align teams, and 
prevented over-selling and out of stocks. 

Conclusion 

The migration to Power BI changed the data culture within RetailX. With this shift, the 
company eƯortlessly trimmed reporting time by more than 60%, enhanced 
interdepartmental harmonization and armed store managers with insights they could 
apply everyday. The combination of data, interactivity and access were critical to their 
modern BI investment in Power BI. 

Takeaway: Adopting a BI tool like Power BI is the key to better visibility into data, as well 
as operational eƯiciency and strategic decision-making. 
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*% detected as AI
AI detection includes the possibility of false positives. Although some text in 
this submission is likely AI generated, scores below the 20% threshold are not 
surfaced because they have a higher likelihood of false positives.

Caution: Review required.

It is essential to understand the limitations of AI detection before making decisions 
about a student’s work. We encourage you to learn more about Turnitin’s AI detection 
capabilities before using the tool.

Disclaimer
Our AI writing assessment is designed to help educators identify text that might be prepared by a generative AI tool. Our AI writing assessment may not always be accurate (i.e., our AI models 
may produce either false positive results or false negative results), so it should not be used as the sole basis for adverse actions against a student. It takes further scrutiny and human 
judgment in conjunction with an organization's application of its specific academic policies to determine whether any academic misconduct has occurred.

Frequently Asked Questions

How should I interpret Turnitin's AI writing percentage and false positives?
The percentage shown in the AI writing report is the amount of qualifying text within the submission that Turnitin’s AI writing 
detection model determines was either likely AI-generated text from a large-language model or likely AI-generated text that was 
likely revised using an AI paraphrase tool or word spinner.
 
False positives (incorrectly flagging human-written text as AI-generated) are a possibility in AI models.
 
AI detection scores under 20%, which we do not surface in new reports, have a higher likelihood of false positives. To reduce the 
likelihood of misinterpretation, no score or highlights are attributed and are indicated with an asterisk in the report (*%).
 
The AI writing percentage should not be the sole basis to determine whether misconduct has occurred. The reviewer/instructor 
should use the percentage as a means to start a formative conversation with their student and/or use it to examine the submitted 
assignment in accordance with their school's policies.

What does 'qualifying text' mean?
Our model only processes qualifying text in the form of long-form writing. Long-form writing means individual sentences contained in paragraphs that make up a 
longer piece of written work, such as an essay, a dissertation, or an article, etc. Qualifying text that has been determined to be likely AI-generated will be 
highlighted in cyan in the submission, and likely AI-generated and then likely AI-paraphrased will be highlighted purple.
 
Non-qualifying text, such as bullet points, annotated bibliographies, etc., will not be processed and can create disparity between the submission highlights and the 
percentage shown.
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Unit 2: Data Import and Transformation 

 

 

Learning Outcomes 

 

1. Understand how to connect Power BI to various data sources, including Excel, 
databases, and online services. 

2. Demonstrate the ability to perform data cleaning and transformation tasks using 
Power Query. 

3. Explain the concept of ETL (Extract, Transform, Load) and the role Power Query 
plays within it. 

4. Apply Power Query functions such as filtering, merging, and shaping data to 
prepare it for analysis. 

5. Integrate Power Query seamlessly with both Excel and Power BI environments. 

6. Evaluate the eƯiciency and reusability of queries created for recurring data 
preparation tasks. 

7. Reinforce concepts through key term reviews, descriptive questions, and a real-
world case study. 

 

 

Content 

 

2.0 Introductory Caselet 

2.1 Connecting to Various Data Sources 

2.2 Data Cleaning and Transformation Using Power Query 

2.3 Understanding Power Query and its Role in ETL 

2.4 Summary 

2.5 Key Terms 

2.6 Descriptive Questions 

2.7 References 
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2.8 Case Study 

  

2.0 Introductory Caselet 

"The Reporting Bottleneck: Observations from the Trenches of Data Hell" 

Background 

Anjali is a logistics company's junior business analyst. Her team must scramble each 
Monday morning to compile a weekly operations report that cobbles together data from 
Excel files, SQL databases, Google Sheets and cloud-based inventory software. Each 
source has a diƯerent format, and melding the sources is a nightmare. 

Her team spends hours copying and pasting data, fixing mismatched formats and 
dealing with broken links. One Monday, a minor mistake in the Excel sheet led to an 
enormous decision on the basis of dubious inventory numbers — and left the company 
missing one of its most important customers. 

In one of the training sessions that week, Anjali gets her first interaction with Power BI 
and Power Query. She’s shocked that Power BI can even directly connect to dozens of 
diƯerent types of data sources, from flat files to cloud services, and automatically 
clean the data using reusable queries. 

She begins to explore Power Query and the light bulb goes oƯ, “this is where business 
intelligence gets powerful – it’s not just about visualizing data but how easy it is to 
connect to data, clean it and shape it before analysis.” 

Critical Thinking Question: 

How does connecting to diƯerent data sources in Power BI help eliminate errors and 
save time when creating reports for a business in the real world? 

2.1 Connecting to Various Data Sources 

Getting to the right data is first step in any BI process. Data Sources: Power BI Data 
Sources supported out-of-the-box are extensive, it give you the ability to import, link or 
stream from virtually anywhere. This freedom of choice allows Power BI to be a single 
tool that can serve all business users across an organization. 

What Can You Connect to Power BI? 

File-Based Sources 

• Excel Workbook (. xlsx,. xls) 

• CSV and Text Files 

• XML / JSON Files 
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• Folder (to join multiple files in a folder) 

Database Sources 

• SQL Server 

• MySQL 

• PostgreSQL 

• Oracle 

• IBM DB2 

• Access Database 

These enable the user to query directly or import from relational databases. 

Online Services & Cloud Sources 

• SharePoint Online 

• OneDrive 

• Azure SQL Database 

• Google Analytics 

• Salesforce 

• Microsoft Exchange Online 

• Web (API or HTML tables) 

Connections such as these support the automatic refresh of data in dashboards, either 
in real-time or based on a schedule. 

Power Platform Sources 

• Power BI datasets 

• Power Apps 

• Dataverse (formerly Common Data Service) 

Other Categories 

• SAP Business Warehouse 

• Hadoop File (HDFS) 

• Spark 

• R and Python scripts 
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• OData feeds 

• Blank Queries (for advanced users) 

Power BI and its Modes of Data Connection 

Import Mode 

o Loads the data into Power BI as a new query. 

o Runs fast but needs to be refreshed in order to contain current data. 

DirectQuery Mode 

o Direct Query connects to the source live (Power BI does not store the data). 

o Live reporting is possible - Timing of live reporting may vary. 

Live Connection 

o Apply to Power BI datasets or Analysis Services. 

o Information is maintained and protected at the source. 

How to Connect Data Source in Power BI Desktop: 

Open Power BI Desktop. 

Click on Home → Get Data. 

You select your type of data source (such as Excel or SQL Server). 

Select or browse to choose your file or server. 

If prompted, enter your credentials or connection settings. 

Choose the table/views you want. 

Preview the data and load, or transform it in Power Query. 

Data Source Connection Best Practice: 

• Check column headers and datatypes always. 

• Use Power Query transforms to prepare the data for loading. 

• Use DirectQuery or filter data at source level in case of bigger datasets. 

• Use Organizational Privacy Levels and keep your credentials safe. 

• Use data gateways to connect on-premises data sources with cloud reports. 

Power BI excels at taking convoluted and arcane data from a variety of disparate 
sources and making it available for immediate analysis and presentation. 
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2.1.1 Importing Data from Excel 

How to use Excel is the most popular software for displaying or storing structured data 
in business and various sectors. Power BI makes it easy and convenient to import data 
from your Excel workbooks. 

How to Import Data from Excel to Power BI: 

Open Power BI Desktop. 

Home → Get Data → Excel. 

Browse and select your. xlsx file. 

A navigator window will open with the available sheets and tables. 

Choose the sheet or named table that you want to load. 

Load to bring directly into Excel, or Transform Data to refine and enhance within Power 
Query. 

Tips: 

• You may find it easier to format your Excel data as a Table within Excel first. This 

ensures that the column names and ranges are correctly identified. 

• If the Excel file has several sheets, you may select to load only what you want and 
combine your selection later in Power Query. 

• When it's loaded the data is on Power BI model, and you can begin to create your 
visuals immediately. 

2.1.2 Connections to Databases (SQL Server, Access, etc.) 

Power BI allows you to connect directly with relational / OLAP Databases, SAP, 
SalesForce and Azure Services such as HD Insights, Tables and above all there is no 
need to export your data warehouse or flat files. 

Common Supported Databases: 

• SQL Server 

• Microsoft Access 

• MySQL 

• PostgreSQL 

• Oracle Database 

• IBM DB2 
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How to connect to a SQL Server using an ODBC connection? 

Home > Get Data > SQL Server. 

- Type the server name and optionally the database name. 

Choose the connection method: 

o Import: Load a copy of the database into Power BI. 

o DirectQuery: Queries against database live data. 

Click OK. 

Authenticate with Windows credentials, Database credentials or OAuth according to 
your configuration. 

Choose the tables or views you want. 

Click Load or Transform. Why Use Database Connections? 

• Ideal for large datasets. 

• Enables live connections and refreshing schedules. 

• Maintains data integrity and security. 

• Supports creation of custom SQL queries to retrieve more complex data. 

Did You Know? 

Are you aware that Power BI’s DirectQuery mode, gives you an opportunity to work with 
real-time data without having to import? When interacting with databases such as SQL 

Server or Azure SQL, Power BI isn’t storing the data but is instead issuing queries to the 
original source in real time. This is desirable for dashboards in which data needed up to 
the minute, as with stock trading or hospital emergency tracking. “Right now, this also 

means performance is highly dependent on the quality of your database and the speed 
of your network.” 

2.1.3 Importing Date 

Handling date and time fields is very important for Power BI as many of the business 
insights depend on time period analysis (e.g., sales over time, month-over-month 
growth and so on.). 

When Factoring in Data Regardless of where you are bringing the data from, date fields 
need to be recognized correctly in order to give you timeline visuals, date hierarchies, 
and filtering abilities. 

Common Issues with Date Fields: 
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• Delivered as text instead of date/time. 

• Heterogeneity of date formats (MM/DD/YYYY vs. DD/MM/YYYY). 

• Missing or null values. 

• Excel serial numbers instead of human-readable dates. 

How To Use Dates in Power BI: 

During Import: 

o Power BI is good at recognizing the date columns. Ensure that the Data Type is set as 
Date/Time. 

In Power Query: 

o Transform → Data Type → Date/Time will fix the formatting problems. 

o If you only want to use the date part of your date-time columns, divide them. 

o For international players, use the "Using Locale" selection. 

Creating Date Hierarchies: 

o Power BI automatically build hierarchies (Year, Quarter, Month, Day) for the field that 
is properly classified as Date. 

o You can have them also in line charts, bar charts, slicers etc. 

Using Calendar Tables: 

o For more complex models, if you want to use some of the time-intelligence functions 
(e.g. YTD, MTD), you can import/create a Date Table with full calendar fields – enable 
calendar year so you can use it in your reports to display data. 

Best Practice: 

Be sure to always see to it that date fields are formatted correctly before they are 

loaded into the model, as correcting them later may interfere with visuals or 
calculations. 

“Did you know that every action you take in Power Query (like renaming a column, 
deleting rows) is recorded using a special-purpose computer language called M (short 
for ‘Mashup’)? With Power Query’s graphical interface, your data transformation steps 
are recording the process as M code that you can see under the Advanced Editor and 
modify but in a readable way. What that means is, it’s no-code out of the box (Power 
Query Editor) but super flexible in terms of being able to script/customize when 
necessary—beginner friendly and power users sexiness.” 

2.2 Data Cleaning and Transformation with Power Query 
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For data to be valuable or useful, it needs to be clean, consistent, and trustworthy. 
Power Query in Power BI provides a powerful set of transformation tools that enable 
users to prepare the data for their analysis all without having to leave Power BI. 

writing code. This chapter deals with common operations used for cleaning the data 
and how imprint a better structure or quality to their analysis. 

2.2.1 De-duping, Blanking and Erroring De-duping 

Receiving duplicate rows can confuse data analysis and soil results. Fortunately, Power 
Query makes easy work of removing them: 

• At Home → Remove Rows → Remove Duplicates. 

• You can choose specific columns—duplicates will only be removed if there are 
matching values in those columns. 

Removing Blank Rows 

Empty rows and columns are bad for while they're a waste of space: 

• Use Remove Blank Rows on the Remove Rows menu. 

• Otherwise, you can also Filter rows containing null or empty value from Filters. 
Removing Errors 

Power Query detects errors during import or transformation (e.g., failed data type 
conversion). 

• Try Remove Errors to clean up a column. 

• Use Keep Errors if you need to pull out error rows for review. These procedures make 
the dataset consistent, free of noise or damage. 

2.2.2 Splitting and Merging Columns 

Occasionally, data is not uniformly structured for example, full names concatenated in 
one column or fields separated by address. 

Splitting Columns 

• Split Column to break down the values by a delimiter (such as comma, space, dash). 

• Example: “John Smith” → “John" and ”Smith". 

• You can split: 

o By delimiter (e.g., comma, space) 

o By number of characters 

o By positions or uppercase/lowercase letters 
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Merging Columns 

• Merge two or more columns influenced by various factors with Merge Columns. 

• Specify separator (space, comma, dash or your custom). 

• For example, if the Username was First Name + Last Name → Full Name 

Both operations are the ways to transform date for reporting or visualization purpose. 

2.2.3 Conversion of Data Types (Text, Numbers and Dates) 

Power BI needs correct data types to its visuals and formulas. Column types can be 
explicitly defined in Power Query: 

• Text - for text, or words (names of the labels or categories in the case of names and 
IDs) 

• Integer/Decimal - Numeric data (such as sales amounts and prices) 

• Date / DateTime – To perform computations based on time (order date, joining date 

etc) 

• True/False: For Boolean values 

How to Change Data Types: 

• Click the data type icon beside the column name, or Transform Change Type. 

•Practicing good data type hygeine before you load data can be very important as it will 
impact sorting, calculation and visuals that you create. 

Incorrect data types can cause: 

• Errors in formulas 

• Inaccurate summaries 

• Broken visuals 

2.2.4 Handling Missing Values 

Missingness is a widely prevalent issue for real-world data. There’s several ways you 
can overcome it in Power Query: 

Replacing Nulls 

• Use Replace Values to replace missing data with a default value (such as “Not 
Available” or 0). 

•This is useful for text columns or numeric fields that are required to have a value. 

Filling Down / Up 
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• Use Transform → Fill → Down or Up to fill empty cells with the value above or below. 

• Helpful when all the values are grouped together but not repeated in every row, such 
as with a form or data set. 

Removing Rows with Missing Values 

• Remove Rows → Remove Blank Rows or Manually filter out the null values. 

• A clue is this occurs for the missing data that has no content, or can't be recovered. 

Replacing with Calculated Values 

• Advanced users can create a conditional column to ifnull null values as the average 
(or other builder value). 

Best practice : Always verify how much row/value are missing and applying method 
according contexte and business rule. 

2.3 Understanding Power Query and Its Role in ETL 

Dataprep- The quality of analysis in any BI system depends on the quality of data 
preparation. Before data is visualized in charts or put to use in reports, it first must be 
transformed through a structured process known as ETL (Extract, Transform, Load). 
Power Query is Microsoft’s answer to this silent killer that was designed to eliminate it 
once and for all in Power BI and Excel. 

Instruction to Student: 

You are an analyst who wants your query to perform the same in Excel and Power BI. 

Open Excel and navigate to Data → Get Data → From File → From Workbook and load a 
sample dataset (such as product sales). 

In Power Query Editor: 

o Filter for only “Electronics” category. 

o Summarize the data by “Product Name” and find out total quantity sold. 

Unpivot the new data to an Excel sheet. 

Close the workbook and open Power BI Desktop. 

Load the query through Get Data → Excel that you have just loaded into Power BI. 
Deliver: Include screen shots of Power Query Editor open in both excel and power bi Fill 
out 100 words how you achieved reusability. 

2.3.1 Concept of Extract, Transform, Load (ETL)  

ETL is the concatenation of: 
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• Extract – Pulling data from disparate sources (files, databases, APIs etc) 

• Transform: A process to clean, re-format or manipulate your data so that it can 
actually be put to use. 

• Load – Sourcing the clean data into a model or tool for exploring and processing as 
necessary. 

What happens here is that raw, dirty data is converted into a neat and orderly one that 
you can now analyze further. 

Example in a Business Context: 

Imagine you're analyzing sales data: 

• Unzip: load CSV files from each region. 

• Transform: Eliminate errors, standardize date-style formats and consolidate product 
categories. 

• Load: Load the last clean dataset to Power BI for dashboard development. ETL is the 
infrastructure of any trustworthy reporting system. 

2.3.2 Role of Power Query in ETL Process 

Power Query is a data preparation tool that’s built in to Excel and other Microsoft 
applications — again, including Power BI. It works with ETL in a very visual way, without 
needing code (but power users can use M language). 

This is the support Power Query provides for each of those steps: 

• Extract: 

o Connects to various sources of data including Excel, SQL Server, Web APIs and more. 

o Supports merging multiple files (e.g., from a folder). 

• Transform: 

o Data cleansing and manipulation, including: filtering, combining, splitting, error-
handling transformations and type conversions. 

o All transformations are saved as a step and can be edited or ordered diƯerently. 

o Supplies the ability to add custom columns, conditional logic and formula based 
transformations. 

• Load: 

o Data is loaded in to the Power BI data model or and Excel worksheet post transform. 
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o Supports reloadable queries to allow auto-update of data. Power Query is easy to 
use, but complex enough to handle most of your ETL tasks. 

 

2.3.3 Steps in Data Transformation Workflow 

In Power Query, you would generally do something along the following lines when 
transforming data: 

Connect to Data Source 

o Select file, database or sub online service. 

Preview and Select Data 

o Pick sheets, tables or fields to work with. 

Apply Transformations 

o Common transformations include: 

 Removing rows/columns 

 Changing data types 

 Filtering rows 

 Renaming columns 

 Splitting columns 

 Merging/joining queries 

 Creating calculated columns 

 Replacing values 

Add Steps to Query 

o Each modification is kept as a “step” in the Applied Steps pane. 

Validate Data 

o Check if data types and structure is as per expectations. 

Load to Data Model 

o Import data into Power BI for analysis and visualization, or into Excel to create 
reports. 

Schedule Refresh (Optional) 

o Auto refresh on data sources (especially in Power BI Service). 
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Power Query is a step by step pipeline, and at any point you can go back to make 
changes in your workflow. 

Did You Know? 

Did you know you can use Power Query to import data from separate.xlsx files in a 
folder… as long as all have the same structure (or not!) or even importing from multiples 
excels into one table and pushing it back the folders? With the Folder connector, it is 
possible to pull and union data from all those files in one go, feeding even new files into 
this pipeline. It is a massive time saver for companies that receive files like sales 
reports, attendance logs or financial statements on a regular basis. 

2.3.4 Advantages of Using Power Query 

Power Query has a number of key strengths when it comes to data preparation: 

No Coding Required 

o Has a simple point-and-click menu like interface for non-technical people. 

Reusable Queries 

o Queries can be saved and refreshed to reflect new data, eliminating redundant work. 

Supports Complex Transformations 

o And even more complex operations such as merging data sets, un-pivoting tables and 
applying conditional logic are handled eƯortlessly. 

Combines Multiple Sources 

o Data from multiple sources can be brought together into a single, consistent dataset. 

Automation-Friendly 

o After the query is created it can be executed automatically, from a schedule (in Power 
BI Service). 

Error Handling 

o Power Query detects the errors at the time of transformation, so users can take 
actions to clean problematic data safely. 

Auditability 

o All steps of the transformation are logged which makes it transparent and easy to 
follow. 

Works with Excel and Power BI 
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o It works the same in both platforms, so is very portable for analysts and business 
users. 

Power Query provides the pathway toward unprocessed data to analytic insights that 
your business is looking for with reduced eƯort on your part. 

2.4 Summary 

 In this module, you learned the core principles of data Preparation with Power Query 
in the context of the power bi. It kicked oƯ with a brief look at how Power BI connects to 
many sources including Excel files, databases, web services and cloud providers. Next, 
learners explored data cleansing and transformation techniques in Power Query—such 
as filtering, merging, changing data types and creating calculated columns. 

 A more in-depth look at ETL-Data Lifecycle (Extract, Transform, Load) surfaced Power 
Query and its lead role in translating raw data to analysis-ready source. Lastly, the 
module covered how Power Query works with Excel as well in cohesion with Power BI 
resulting in reusable queries between platforms and a frictionless end to end data 
pipeline. 

 Proficiency in these tools and workflows enables learners to automate mundane 

data tasks, prevent errors, and build clean datasets to fuel transformational business 
analysis. 

2.5 Key Terms 

From – The information source (file, database, site, or cloud). 

ETL (Extract, Transform, Load) – The process of assembling a data set from various 
sources, and then moving it into another system. 

Power Query – The tool by Microsoft used to connect, clean, transform and load in 
Power BI as well as Excel. 

Data Transmutation – The act of transposing unprocessed data into a processed form 
via editing, cleaning or otherwise modifying said data prior to the final product. 

Applied Steps – A list of transformations performed in Power Query, which can be 
reviewed, modified or deleted. 

Query Editor – The Power BI/Excel interface where you prepare your data. 

Merging Queries – A technique for bringing together data from a few (or more) tables 
that share common values in key columns. 

Append Queries – One way of stacking tables on top of one another when their 
columns match up. 
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DirectQuery – It’s a Power BI mode where the data is kept in the source, and queried 
directly to it instead of importing. 

Data Model – The Power BI or Excel construct that stores the clean and prepared data 
for analysis and visualization. 

2.6 Descriptive Questions 

What is ETL and why does it matter in BI? 

Name three popular kinds of data sources that Power BI can connect. 

What are the key steps of data transformation in Power Query? 

Compare and contrast merge queries vs append queries in Power Query. 

How does Power Query relate to both Excel and Power BI? 

Why would you want to save your steps in Power Query’s Applied Steps pane? 

Can you give me two examples of "replacements" that are usualy used in Power Query. 

How does Power Query reduce manual data preparation errors? 

2.7 References 

1. Microsoft Documentation on Power Query: https://learn.microsoft.com/en-
us/power-query 

2. Gil Raviv (2018). Collect, Transform and Combine Data Using Power Query in 
Excel and Power BI. Microsoft Press. 

3. Ken Puls & Miguel Escobar (2021). M is for Data Monkey: A Guide to the M 
Language in Power Query. Holy Macro! Books. 

4. Microsoft Power BI Learning Path: https://learn.microsoft.com/en-
us/training/powerplatform/power-bi 

5. DAX Guide & Power Query M Reference: https://dax.guide/ | 
https://docs.microsoft.com/en- us/powerquery-m/ 

2.8 Case Study 

“Get It Done with HR Data Analysis in Power Query” 

Introduction 

HRPro Solutions is a boutique-sized HR consulting firm and they have multiple clients 
data in their database. Their analysts were wasting countless hours picking and pulling 
data from Excel files, wrangling CSV exports, and extracting HRMS database reports—
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frequently resulting in inconsistent data that courted long lag periods to generate insight 
for clients. 

Background 

Historically, HRPro analysts spent hours cleaning and combining almost a hundred 
files via Excel. There were diƯerent file formats, names and stuctures for each client. 
Doing this manually took a few days per client per month. 

Following a workshop, in Power BI and Power Query, the team decided to introduce a 
centralized data transformation pipeline using Power Query within Power BI. In weeks, 
they automated 80% of their data preparation. 

Problem Statement 1: Manual Data Cleaning And Inconsistency 

Analysts spent hours doing mundane tasks such as deleting blank rows, formatting 
dates into consistent format, and renaming fields – with a high chance for human error. 

Solution: 

Power Query wasleveraged to create standardized, reusable trasformation steps. The 
consultants developed templates that could be used with a variety of client data, after 
minor modifications. 

MCQ 1 

What is the Power Query feature you would use to automate and share steps across 
other datasets? 

A) Quick Analysis 

B) Applied Steps 

C) Dashboard Templates 

D) Visual Filters 

Answer: B) Applied Steps 

(2) Problem 2: Unable to Aggregate Client Data Easily 

Analysts had diƯiculty bringing multiple files and tables together, particularly when 
names of columns were slightly diƯerent. 

Solution: 

The data was consolidated using Power Query’s Merge Queries and Append Queries, 
with custom-columns added to identify the source for each client. Mismatched 
headers were dealt with by conditional statements and mapping to columns. 

MCQ 2 
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What is the best way to append several datatables with identical structure in Power 
Query? 

A) Merge Queries 

B) Conditional Formatting 

C) Append Queries 

D) DAX Relationships 

Answer: C) Append Queries 

Conclusion 

TRIAL CASE: HRPro Solutions now takes from 3 days to a few hours for data 
preparations - using Power Query. That enabled them to concentrate on data analysis 

and client advisories, which in turn amplified eƯiciency, accuracy and client 
satisfaction. Their reusability and automation with Power Query was a game-changer. 
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*% detected as AI
AI detection includes the possibility of false positives. Although some text in 
this submission is likely AI generated, scores below the 20% threshold are not 
surfaced because they have a higher likelihood of false positives.

Caution: Review required.

It is essential to understand the limitations of AI detection before making decisions 
about a student’s work. We encourage you to learn more about Turnitin’s AI detection 
capabilities before using the tool.

Disclaimer
Our AI writing assessment is designed to help educators identify text that might be prepared by a generative AI tool. Our AI writing assessment may not always be accurate (i.e., our AI models 
may produce either false positive results or false negative results), so it should not be used as the sole basis for adverse actions against a student. It takes further scrutiny and human 
judgment in conjunction with an organization's application of its specific academic policies to determine whether any academic misconduct has occurred.

Frequently Asked Questions

How should I interpret Turnitin's AI writing percentage and false positives?
The percentage shown in the AI writing report is the amount of qualifying text within the submission that Turnitin’s AI writing 
detection model determines was either likely AI-generated text from a large-language model or likely AI-generated text that was 
likely revised using an AI paraphrase tool or word spinner.
 
False positives (incorrectly flagging human-written text as AI-generated) are a possibility in AI models.
 
AI detection scores under 20%, which we do not surface in new reports, have a higher likelihood of false positives. To reduce the 
likelihood of misinterpretation, no score or highlights are attributed and are indicated with an asterisk in the report (*%).
 
The AI writing percentage should not be the sole basis to determine whether misconduct has occurred. The reviewer/instructor 
should use the percentage as a means to start a formative conversation with their student and/or use it to examine the submitted 
assignment in accordance with their school's policies.

What does 'qualifying text' mean?
Our model only processes qualifying text in the form of long-form writing. Long-form writing means individual sentences contained in paragraphs that make up a 
longer piece of written work, such as an essay, a dissertation, or an article, etc. Qualifying text that has been determined to be likely AI-generated will be 
highlighted in cyan in the submission, and likely AI-generated and then likely AI-paraphrased will be highlighted purple.
 
Non-qualifying text, such as bullet points, annotated bibliographies, etc., will not be processed and can create disparity between the submission highlights and the 
percentage shown.
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Unit 3: Introduction to Power BI 

 

Learning Outcomes 

1. Understand the fundamentals of data modeling in Power BI, including 
relationships, tables, and data types. 

2. Describe and apply DAX (Data Analysis Expressions) for creating custom 
calculated fields and measures. 

3. Use DAX functions to calculate minimum and maximum values across various 
data dimensions. 

4. Perform aggregation operations such as SUM, AVERAGE, COUNT, and 
DISTINCTCOUNT using DAX. 

5. Implement time intelligence functions in DAX to compare data over time (e.g., 
YTD, QTD, MTD). 

6. Summarize the key concepts and terminology introduced in Power BI and DAX. 

7. Answer descriptive questions to reinforce theoretical and practical 
understanding. 

8. Apply learned concepts through a real-world case study using Power BI and DAX 
for data visualization and analysis. 

 

 

 

Content 

3.0 Introductory Caselet 

3.1 Basics of Data Modeling in Power BI 

3.2 Introduction to DAX (Data Analysis Expressions) 

3.3 DAX – Minimum and Maximum 

3.4 Aggregation Basics 

3.5 Time Intelligence 

3.6 Summary 

3.7 Key Terms 
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3.8 Descriptive Questions 

3.9 References 

3.10 Case Study 

  

3.0 Introductory Caselet 

"The Dashboard Dilemma: Dialogue Between Riya and Her Mentor" 

Background: 

Riya, a data analyst at a fast-growing e-commerce startup in Bengaluru, is stressed. As 

it stands right now, she’s under the gun every day to produce several reports a day and 
respond quickly to stakeholder questions and inconsistencies in data pulled from 
diƯerent sources. So even when she’s spending long hours in Excel and on ad hoc SQL 
queries, she believes that she’s really only reacting — not doing any real analysis. 

One evening, she encounters her former teacher, Mr. Rajan, at a university alumni 
dinner. They grab some coƯee and Riya rants. 

‘Na ka,’ Mr. Rajan smiles soft and says, 

“You don’t need more time in the day — you need a model that works for you. Before 
you analyze, you must 

organize. That is the principle of data modeling.” 

He pulls out a napkin and scribbles some tables, relationships and measures. 

“Think of your data as a city. And without a proper map, you’ll continue to get lost. “But 
when you build it” — the model, meaning the roads, the intersections — “you can drive 
anywhere.” 

In the coming weeks, he teaches Riya how to work with Power BI. She is building a 
clean data model, defining key relationships and replacing static reports with dynamic 
dashboards. Her workload is reduced, but so are her insights. Her team begins to look 
at her not only as a report author — but as a strategist. 

Taking Control: Through adopting the power of modeling, we witness a shift in Riya from 
passive to active behavior. 

Critical Thinking Question: 

In an intricate business world, how does a formal data model drive better decision-
making than ad hoc reporting? 

3.1 Basics of Data Modeling in Power BI 
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Data modeling in Power BI is the procedure of putting together and arranging diƯerent 
sets of data into a model with relationships, that allows you to perform easy and 
smooth analysis. Rather than having data randomly sitting in separate files or tables, 
Power BI lets you pull them together and create logical relationships between the 
tables. This means you can do complex calculations on your data and have accurate 
results without having to write a lengthy formula or entering the same data over again in 
a separate table. 

Picture data modeling as creating a blueprint or map for how you want your data to be 
organized, related and analyzed. It prevents from repeating and takes out human error, 
productivity when build reports/dashboard. 

Power BI Data Modeling This is what data modeling in Power BI usually consists of: 

• Importing in tables from one or more sources 

• Defining relationships between tables 

• Developing through DAX calculated fields and measures 

• Cleanging and manipulation of the data as required 

When you design your data model well, the user can analyze data faster and better, 
make better engineering decisions as a result and minimize fixing data manually. 

3.1.1 Concept of Data Modeling in BI 

BI Data Modelling in business intelligence (BI) the process of structuring data to enable 
eƯicient reporting and analysis. It’s not a matter of replacing the data – but rather it's 
about the way it is linked and interpreted. 

In Power BI, you typically start by creating tables as part of your data model. There are 
rows and columns in each table just like an Excel file. But rather than going with a 
single big table for all data, modeling divides the mass into smaller, cohesive tables. 
For example: 

• One table may hold details about customers. 

• There is another table that describes orders. 

• Details of products are in a third table. 

Insteading pasting the contents of customer and product into every order, Power BI 
creates relationships between these tables. 

Data modeling at a conceptual level consists of: 

• Entities: These are the things you want to model, such as customers, orders and 
products. 
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• Attributes: This is the information about the entities (i.e., Customer Name, Order 
Date, etc.) 

• Relationships: These are the logical relationships between multiple tables, which 
show how information in one table is connected to that in another. 

A good data model: 

• Reduces data duplication 

• Helps to speed up and makes reporting more accurate 

• Allows cross-comparison of categories in analysis 

The Model View in Power BI presents connection between all the table and it allows 
users to visually define as well as edit these relations. 

3.1.2 Relationships Between Tables (One-to-Many, Many-to-Many) 

Relationships determine how tables are related to each other in a data model. In Power 
BI, you use relationships to bring together columns from multiple tables so that you 
can examine rows with related data. For instance, the Customer ID column in the 
“Orders” table can be related to the Customer ID in customer. This common field makes 
it possible for Power BI to join the two tables. 

Depending on the way in which data is structured, one describes various types of 
relationships. The most common ones are: 

One-to-Many (1:*) Relationship 

This is the relationship type used by data modelling in a majority of cases. 

Example: 

• Many orders can be placed by one customer. 

• Soo, the “Customers” table has one row for each customer. 

• The “Orders” table has (potentially) many records for each customer (one per order). 

In Power BI: 

• The "one" side is typically the dimension table (such as Customers). 

• The “many” side is simply the fact table (say, Orders). 

When you connect these tables through the common field such as Customer ID, Power 
BI can summarize and filter 

the “Orders” table based on the “Customers” table’s data. However, in a many-to-many 
relationship, a value in one table can match multiple values in another table, and vice 
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versa. This sort of connection is considerably more complicated and should be handled 
with caution. For instance: 

• One product can be in multiple categories 

• One category can have multiple products. These statements create a many-to-many 
relationship between the “Products” table and the “Categories” table. Power BI 
addresses many-to-many relationships using a so-called bridge table that serves as an 
intermediate or mapping one and unites the two tables via separate one-to-many 
relationships. However, Power BI even allows the user to directly specify a many-to-
many relationship without an explicit bridge table. However, such action will lead to 
ambiguity in data filtering and consolidation processing unless handled with caution. 
These are the main principles of how relationships work in Power BI: 1. Relationships 
are determined by the correlation between key columns . 2. Filters implemented to one 
table also apply to another. 3. A user can specify the cardinality and cross-filter 
direction . 4. There can be active and inactive relational dependencies.  

3.2 Introduction to DAX (Data Analysis Expressions) 

DAX is the right choice when you need to make dynamic, context-sensitive or custom 
calculations — such as year-to-date sales, running totals and comparing one element 
with its total. 

3.2.1 What is DAX and Why Use It?  

DAX is a formula language that was originally developed by Microsoft and Power BI 
users can use it to create custom calculations and aggregations in Power BI models. It 
looks like an Excel formula, but it’s more potent and geared to relational (tables) and 
columnar (cuboids) data models. 

Why use DAX? 

DAX is used to: 

•Build calculated columns and measures using the data you have already loaded. 

• Do filtering, aggregations and logical comparisons. 

• Support advanced analytics including time intelligence (YTD, QTD and MTD). 

• Make calculations context-dependent, so they will adjust their results according to 
the filters that we add in a report or dashboard. Without DAX, Power BI reports can 
only have simple summaries. DAX permits users to automate complicated business 
logic inside the model. 

3.2.2 Syntax and Structure of DAX Formulas 

Every DAX formula begins with an equal to sign (=) and consists of: 
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• Formulas: Predefined calculations like SUM, AVERAGE, IF, CALCULATE. 

• Columns and Tables: Referenced via square brackets for columns ([Sales]) and table 
names when necessary. 

• Operators: Arithmetic (+, -, *, /), relational (=, >, =, <=) and logical (&&, || and NOT). 

Basic Syntax Example: 

= SUM(Sales[Revenue]) 

This formula provides the total sales amounts by summing all figures in the Revenue 
column of the Sales table. 

Using a condition: 

= CALCULATE(SUM(Sales[Revenue]), Sales[Region] = "Eas t) This gives the total sales 
amount for east region. 

DAX formulas are context sensitive, which means the outcome of a formula can be 
diƯerent based on what kind of filters you are using or how the visuals are sorted. 

3.2.3 Calculated Columns vs Measures 

With Power BI and DAX you can create two diƯerent types of expressions: 

Calculated Columns 

•Generated for an individual row of a table. 

Computed on load or refresh of data. 

• Memorized as part of the table. 

• You need new fields of data that are available elsewhere in the Dataset and which you 
can treat as any other columns (e.g., make your own categories from existing 
description). 

Example: 

Profit = Sales[Revenue] - Sales[Cost] 

Measures 

• Computed at runtime depending on the filter context in a report or visual. 

• Not cached—computed as required. 

• Great for summarizing or averaging data. 

• Primarily used for visuals (for example, cards, tables, and charts). 

Example: 
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Total Revenue = SUM(Sales[Revenue]) 

 

Key DiƯerences: 

 
 

Feature Calculated Column Measure 

Calculation Context Row-by-row in table Depends on filter context in visuals 

Storage Stored in the table Not stored; computed on demand 

Use Case Creating new fields for slicing Summarizing data in visuals 

 

Did You Know? 

But did you know that calculated columns are computed at refresh time and MDX is pre-
calculated in memory, all measures/tree nodes being evaluated on-the-fly during 
interaction with the report? 

This may result in bloated model size and sluggish performance if overused. Measures, 
on the other hand are more performance-wise and are recommended for most 
calculations that include aggregation. 

3.3 DAX – Minimum and Maximum 

In Power BI, identifying the minimum and maximum values in a dataset is a common 
and essential task in data analysis. DAX provides built-in functions MIN() and MAX() to 
perform these operations easily and accurately. 

These functions are useful in a variety of scenarios, such as identifying the lowest-
performing product, determining the highest revenue month, or setting thresholds in 
dashboards. Both MIN() and MAX() can be used in calculated columns, measures, and 
within more complex formulas using functions like CALCULATE() or FILTER(). 

 

3.3.1 Using DAX MIN() Function  

DAX has a variety of functions covering some diƯerent scenarios, they can be classified 
in: 

Aggregation Functions 

• SUM(): For summing up all numbers in a column. 

• AVERAGE(): Takes the average of a column. 

• MIN(), MAX(): Returns the minimal or maximal value. 
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• COUNT(), COUNTA(), DISTINCTCOUNT(): Count values. 

Logical Functions 

• IF(): Return a value depending on the condition. 

• AND(), OR(), NOT(): Logical operators. Example: 

= IF(Sales[Revenue] > 10000, "High", "Low") 

Text Functions 

• CONCATENATE(): Joins two text strings. 

• LEFT(), RIGHT(), MID(): Returns a portion of a text string. 

• UPPER(), LOWER(): Changes text to either upper or lower case. 

Date and Time Functions 

• TODAY(), NOW(): Current Date or Time. 

• YEAR(), MONTH(), DAY(): Get parts of the date. 

• DATEDIFF(): Finds diƯerence between dates. 

Filter Functions 

• CALCULATE(): Alters filter context to evaluate the expression. 

• FILTER(): Returns a table that has been filtered to include only rows that satisfy 
custom criteria. 

• ALL(): Clears all filters on a table or column. 

Operators 

• Arithmetic: +, -, *, / 

• Comparison: =, >, =, ) Or: 

MIN(, ) 

Example 1 In the first example, we will find minimum sales value. 

MinSales = MIN(Sales[TotalSales]) 

This is to get the minimum TotalSales in sales table. 

Example 2: Comparing two values 

MinMargin = MIN ( Sales[ProfitMargin], Sales[TargetMargin])This formula shows the 
smaller value for each row. Use in Context: 
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MIN() is influenced by the filter context. So, for instance if applied to a visual filtered by 
region it will return the minimum value only for that region. 

3.3.2 Using DAX MAX() Function  

MAX() function is used to get the largest value in a column or may be among various 
columns. 

Syntax: 

MAX() Or: 

MAX(, ) 

Example 1: Maximizing Revenue 

MaxRevenue = MAX(Sales[Revenue]) 

This feature corresponds to the largest revenue amount that appears in the dataset. 

Example 2: Comparing two values 

MaxMargin = MAX(Sales[ProfitMargin], Sales[TargetMargin]) This is the sign of the 
greater value by each row. Use in Context: 

Similar to MIN(), the MAX() function is also influenced by filter context. Itll provide you 
with the highest within your present report choice (ie.By merchandise, by group or by 
date variety). 

3.3.3 Business Applications of MIN() and MAX() 

The MIN() and MAX() functions are so commonly used in business intelligence for a 
number of reasons. Here are a few common use cases: 

Performance Benchmarking 

• MIN(): Find the minimum of a bunch branch, product or employee. 

•MAX(): The best-selling products or top performers will be visually highlighted. 

Example: 

Display the product with maximum data in terms of sales amount based on a month at 
a time from Sales[SalesAmount]. 

Threshold Analysis 

• Use MIN() and MAX() to evaluate current performance against targets or limits. 

Example: 
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You can use conditional formatting to color values in red if profit is less than a certain 
minimum. 

Time-Based Reporting 

• Calculate the earliest and largest transaction dates with MIN(Date[OrderDate]) and 
MAX(Date[OrderDate]). 

Example: 

Show the first and last sale date for a customer. 

Inventory and Stock Management 

• Determine the top and bottom stock items to facilitate material management 
decisions. 

Example: 

Create a KPI card to MIN(Inventory[StockLevel]) then for the alerting when products 
quantities are low. 

Financial Analysis 

• Show best and worst times financially on dashboard by using MAX() and MIN() over 
KPIs like profit, revenue or cost. 

And these are simple little functions, but when mixed with other DAX formulas and filter 
logic things get really interesting from a business intelligence perspective. 

“Activity 1: Best and Worst Performing Products” 

You are given a dataset that includes sales information of diƯerent items in several 
areas. Use DAX functions to identify: 

The highest sales in total across all country. 

The lowest sales product in the present quarter. 

In Power BI, create two KPIs (with card visuals) to show: 

o Maximum Sales Value 

o Minimum Sales Price (Value) Next, respond to the following: 

• What do you notice in the top and bottom products? 

• Recommend one approach for management to experiment with based on your 
findings. Turn in your Power BI file and 150–200 word write-up of what you found. 

“Activity 1 – Best and Worse Products Analysis” 
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You are given a dataset which consists of sales data of products in various regions. Use 
DAX functions to identify: 

The world's best-selling product of all times. 

The lowest selling quarter line. 

How to Display Implement two KPIs (using card visuals) in Power BI with below values: 

o Maximum Sales Value 

o Minimum Sales Figure Now do the following:. 

• What do you notice about the performance of the low and high products? 

• Describe one action that management might take as a result of these insights. Please 
provide both your Power BI file and a brief report of your results (150–200 words). 

3.4 Aggregation Basics 

Aggregation means the procedure through which data are represented by one or a few 
numbers using mathematical functions, such as sum, average, count and distinct 
count. Aggregates are the workhorse of data analysis and reporting in Power BI 
because they allow you to repurpose big piles of numbers into meaningful summaries. 

DAX (Data Analysis Expressions) includes a wealth of built-in aggregation functions 
that are easy to incorporate into your calculations, and powerful enough to create 
insights using advanced analytics. The knowledge and insight into how these 
functionalities work, on the part of our users, enable them to correctly analyze data and 
design interactive dashboards. 

3.4.1 SUM() Function in DAX 

Purpose: 

The SUM() function calculates the sum of all numeric values in a column. 

Syntax: 

SUM() 

Example: 

TotalSales = SUM(Sales[SalesAmount]) 

This measure gives me the sum of all values in the SalesAmount column which is 
present in the Sales table. 

Behavior: 

• Works only with numeric columns. 
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• Is aware of the filter context, whereby it computes results based on current filters 
applied in the report. 

Common Use Cases: 

• Finding the total, cost or profit. 

• Combining sales over time, products or areas. 

3.4.2 AVERAGE() Function in DAX  

The AVERAGE() function calculates the average of a set of numerical values in a 
column. 

Syntax: 

AVERAGE() 

Example: 

AvgSales = AVERAGE(Sales[SalesAmount]) 

This calculation provides the average sales value per transaction. 

Behavior: 

• Works only with numeric data. 

• Considers existing or current filters in the report. 

Common Use Cases: 

• Finding average order value. 

• Establishing average delivery time or customer ranking. 

• Trend analysis Through an analysis of period averages over time. 

3.4.3 COUNT() and DISTINCTCOUNT() Functions  

Purpose: 

Count the number of rows that have non blank values in a column. 

Syntax: 

COUNT() 

Example: 

OrderCount = COUNT(Sales[OrderID]) The order count in the data set. 

DISTINCTCOUNT() 

Purpose: 
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Counts the number of distinct values in a column. 

Syntax: 

DISTINCTCOUNT() 

Example: 

UniqueCustomers = DISTINCTCOUNT(Sales[CustomerID]) A value that represents how 
many unique customers placed orders. 

 

DiƯerences Between COUNT and DISTINCTCOUNT: 

Function Counts Total Rows Counts Unique Values 

COUNT() Yes No 

DISTINCTCOUNT() No Yes 

 

Common Use Cases: 

• Tallying the number of transactions, customers or products in total. 

• Deciphering one-of-a-kind users, vendors, or sales regions. 

• Creating KPIs for dashboards. 

3.4.4 Application Scenarios of Aggregated Data in Business Reports 

Sales Reporting 

• SUM(): Total sales by region, product or month. 

• AVERAGE(): Average size per order or average sales per customer. 

• COUNT(): Number of sales transactions. 

• DISTINCTCOUNT(): Count of unique products sold. 

Customer Analysis 

• We can use the DISTINCTCOUNT() to figure out how many unique customers bought 
something. 

• Use AVERAGE() to calculate the average spending per customer. 

Inventory Management 

• SUM(): Sum of all the stock available on hand in all warehouses. 

• COUNT(): how many products are in stock now. 
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• DISTINCTCOUNT(): Total number of Unique SKUs. 

Human Resources 

• COUNT(): Total number of employees. 

• DISTINCTCOUNT() : Count of job titles or deparment unique. 

• AVERAGE(): Average age, salary or experience. 

Marketing Campaigns 

• COUNT(): Number of leads generated. 

• DISTINCTCOUNT(): Number of unique campaign_sources. 

• SUM(): Total marketing spend. 

• AVERAGE(): Average cost per lead. 

The decision of which aggregation function to use will depend on the business 
question in every case. When applied properly, these DAX functions help generate 
meaningful insights for high impacting visuals and reports in Power BI. 

"Activity 2: Developing an Aggregated View for a Sales Dashboard" 

You are a junior data analyst at a retail company. Using the provided sales dataset: 

Create four DAX measures: 

o Total Sales (using SUM()) 

o Average Order Value (using AVERAGE()) 

o Total Transactions (using COUNT()) 

o Unique Customers (using DISTINCTCOUNT()) 

Create a simple dashboard in Power BI that demonstrates: 

o A summary table of the above measures by product category 

o Two graphs: A bar graph that displays overall sales by region and a line graph that 
shows monthly sales distribution 

Instructions: 

• Use slicers to enable filtering by year and region. 

• Ensure your visualizations change according to user interaction. 

Upload your Power BI dashboard file plus, write up a brief reflection (about 100 – 150 
words) on how aggregation helped make sense of information & easy to understand. 

Page 16 of 23 - AI Writing Submission Submission ID trn:oid:::3618:127350294

Page 16 of 23 - AI Writing Submission Submission ID trn:oid:::3618:127350294



3.5 Time Intelligence 

Time intelligence Power BI Time intelligence in Power BI is a set of techniques for 
calculating information over time-based data. It allows for comparison and tracking of 
performance over periods of time, similar to Total YOY Growth, Monthly Trends or 
Cumulative Totals. 

Time intelligence is critical in business analysis since most of the KPIs are measured 
over time — be it daily, monthly, quarterly or yearly. 

3.5.1 Concept of Time Intelligence in Power BI 

Time intelligence is about recognising how your data behaves over time, and using this 
to help: 

• Look at diƯerences from the present to previous years (whether it is this year versus 
last year). 

• Trend analysis (such as rolling up sales over months). 

• Aggregate over periods (e.g., mean by month). 

Time intelligence in Power BI is conducted with DAX functions that only works on a 

properly design date table. These functions will work only with the right date table that 
have relationship with the fact table. 

Some of the typical time intelligence calculations include: 

• Year-to-date (YTD) sales 

• Month-over-month (MoM) growth 

• Rolling 12-month average 

• Same period last year (SPLY) 

These computations provide greater understanding of business trends and permit 
stake holders to make informed decisions. 

3.5.2 Understanding Date Tables: Calendar vs Auto-Date 

 This is the twenty-ninth post in a series attempting to create a usage guide for the 
Power BI and SSAS community. 

Date table is a table that has one row for every date in the range and facilitates time-
based analysis. 

DiƯerent Date Tables in Power BI: 

Auto-Date/Time Table: 
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• Automatically generated by Power BI when you drag a date field into visuals. 

• Easy to use, but not very flexible. 

• Would not be useful for more complex models or with date fields that are not 
independently related. 

Custom Calendar Table: 

• A custom table that contains a contiguous series of dates. 

• OƯers full control and flexibility. 

• Can be expanded to have other columns like Year, Quarter, Month Name, Weekday, 
Fiscal Year etc. 

Creating a custom calendar table: 

Calendar = CALENDAR(DATE(2018,1,1), DATE(2025,12,31)) 

Extended version with columns: 

Calendar = ADDCOLUMNS( 

CALENDAR(DATE(2018,1,1), DATE(2025,12,31)), "Year", YEAR([Date]), 

"Month", FORMAT([Date], "MMMM"), 

"Month Number", MONTH([Date]), "Quarter", "Q"& FORMAT([Date], "Q") 

) 

As well, a date table is used to identify that it is a "Date Table" by checking in Power BI 
so DAX functions can work properly when using time intelligence tasks. 

Did You Know? 

Did you know that Power BI has a hidden date table feature, which automatically 
creates hidden date tables for each date field you put on the model even though you 
don’t ask it to? This invisible table uses memory and can lead to unintended 
relationships, which may be particularly apparent with large data sets or complex 
models. 

That’s the advice from experienced modelers: turn oƯ Auto-Date/Time in Power BI 
settings and instead employ 

customized calendar tables, which are eƯicient, legible and flexible. 

3.5.3 Year-to-Date (YTD) Calculations  

Year-to-Date (YTD) is the sum of a measure to date from the start of the year. 
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DAX Function: 

TotalSalesYTD = TOTALYTD(SUM(Sales[SalesAmount]), Calendar[Date]) 

• The TOTALYTD() function takes a year-to-date running total of the measure provided. 

• It must have a proper date column in it from related (or marked) date table. 

Use Case: 

Monitor cumulative revenue or expenses from January 1 through the latest data point 
for the current year. 

3.5.4 Quarter-to-Date (QTD) and Month-to-Date (MTD) Calculations  

Quarter\-to\-Date \(QTD\) and Month\-to\-Date \(MTD\) 

Definition: 

Quarter-to-Date Accumulates the totals from the start of the current quarter to 
present. 

DAX Function: 

TotalSalesQTD = TOTALQTD(SUM(Sales[SalesAmount]), Calendar[Date]) 

Use Case: 

Assess sales performance in the current fiscal or calender quarter. 

Month-to-Date (MTD) Definition: 

Month-to-Date: This is the sum of values from the start of this month, up to today’s 
date. 

DAX Function: 

TotalSalesMTD = TOTALMTD(SUM(Sales[SalesAmount]), Calendar[Date]) 

Use Case: 

Track current sales growth as data continues to roll in daily. 

3.5.5 Practical Applications of Time Intelligence 

Double-ended probe pulse time-intelligence Time intelligence is commonly employed 
in many fields for world-time performance assessment. Some real-world applications 
include: 

Financial Reporting 

• Year-to-date revenue and profit tracking 
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• Quarterly earnings comparison 

• SPLY comparison for the same period of last year 

Sales Dashboards 

• Monitor month-to-date sales 

• See how your current quarter to date sales match up versus the previous quarter. 

• Analyze seasonal trends and patterns 

Human Resources 

• Trend the growth of employee count over time 

• Look at current and previous attrition ratios 

Marketing Campaigns 

• Compare the eƯicacy of your campaigns between months 

• Track leads or conversions year-to-date 

Inventory and Supply Chain 

• Recognise stock movement patterns over months 

• Monitor cumulative product returns 

In any of these cases, time intelligence allows business users to perform comparisons, 
analyze trends and cumulate values; hence, they can make more strategic decisions 
based on historical patterns. 

Knowledge Check 1 

Multiple Choice Questions (MCQs) 

Which of the following is a correct description of a measure in Power BI? 

A text field used to filter visuals 

B. A relative value that will change depending filter applied 

C.An internally added column to a table D.A user-added column to a table 

D. A field that is used to link two tables together 

Answer: 

What is a Date Table for the Power BI Time Intelligence functions? 

A. To cache user credentials to access the report 

B. For creating calculated columns for string manipulation 
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C. To support period calcualtions like YTD, QTD and MTD 

D. To increase data refresh speed 

Answer: 

What DAX function is used to calculate unique values in a column? 

A. COUNT() 

B. CALCULATE() 

C. DISTINCTCOUNT() 

D. COUNTA() 

Answer: 

In A one to many relationship which table is on the "one" side usually? 

A. Fact table 

B. Calendar table 

C. Dimension table 

D. Bridge table 

Answer: 

3.6 Summary 

 We started the unit with a discussion around data modelling and DAX within Power 
BI, discussing them at lievel 100. The chapter started with an introduction to the 
fundamentals of data model design, pointing out how structured table relationships 
are key enablers for accurate and scalable data analysis. 

 We then learned DAX, a miraculous formula language and how to use it for custom 
calculation. Students reviewed DAX expressions syntax and structure, and learned the 

diƯerence between calculated columns and measures. 

 Major DAX functions; eg. MIN(), MAX(), SUM(), AVERAGE(), COUNT() and 
DISTINCTCOUNT() 

were thoroughly covered, then we move onto Time Intelligence. In this review, students 
were using DAX to do period based calculations (YTD, QTD, MTD) utilizing well 
maintained date tables. 

 All these aspects combined create together the premises to analyze the data and 
easily develop dashboards in Power BI with great impact on real-time decisions, 
covered by diƯerent scopes in a business. 
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3.7 Key Terms 

• Data Modeling: Organizing data into related tables and dimensions for analysis and 
reporting. 

• Relationship: Logical association between two tables, generally common key 

column. 

• DAX (Data Analysis Expressions) A formula language in Power BI for creating custom 
calculations. 

•Calculated Column: A new column in a table you create using DAX, computed row-by-
row. 

• Measure: A calculated field that uses Data Analysis Expressions (DAX) to aggregate 
data based on the filter context. 

• Aggregation: The act of summarizing data by using functions, such as sum, average, 
and count. 

• Time Intelligence: The collection of DAX funtions that are used to calculate values over 
periods of time (i.e. Year-To- Date, Month-To-Date). 

• Calendar Table: A table that only contains a uniform range of dates and tends to be 
used for time based calculations. 

• Filter Context: The collection of filters that are directly applied to the data which is 
used in evaluating DAX calculations. 

3.8 Descriptive Questions 

Describe the significance of data modeling in Power BI. How does it make reports 
faster and more accurate? 

What is the diƯerence between 'Calculated Column' and 'Measure' in Power BI? 

Issue-4 Write a DAX formula that returns the overall sales Amount and explain its 
components. 

Explain, how MIN() and MAX() functions works in DAX. Provide some real-world 
business applications of how they’re used. 

DiƯerences Between COUNT() and DISTINCTCOUNT() According to DAX 
documentation, below are how these 2 functions diƯer: “DISTINCTCOUNT Counts the 
number of distinct values in a column or expression. When would you use each? 

What is Power BI Time Intelligence? Explain how a date table allows time-based 
calculations. 

Write DAX formulas to calculate sales by YTD and MTD. 
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Explain some real use of aggregation functions in relation to diƯerent domains 
(Finance, HR and marketing etc). 

Explain the concept of Filter Context in DAX. How does it impact a measure’s results? 

Why would you use a calendar table instead of Power BI's Auto-Date? 

3.9 References 

1. Microsoft Documentation – DAX Reference: https://learn.microsoft.com/en-
us/dax/ 

2. Microsoft Power BI Learning Center: https://learn.microsoft.com/en-us/power-
bi/ 

3. Russo, M., & Ferrari, A. (2020). The Definitive Guide to DAX: Business intelligence 
for Microsoft Power BI, SQL Server Analysis Services, and Excel. Microsoft Press. 

4. Power BI Community and Forums: https://community.powerbi.com/ 

5. SQLBI – Articles and Videos by Marco Russo and Alberto Ferrari: 
https://www.sqlbi.com/ 

More correct answers to Knowledge check : 

B 

C 

C 

C 

B 
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*% detected as AI
AI detection includes the possibility of false positives. Although some text in 
this submission is likely AI generated, scores below the 20% threshold are not 
surfaced because they have a higher likelihood of false positives.

Caution: Review required.

It is essential to understand the limitations of AI detection before making decisions 
about a student’s work. We encourage you to learn more about Turnitin’s AI detection 
capabilities before using the tool.

Disclaimer
Our AI writing assessment is designed to help educators identify text that might be prepared by a generative AI tool. Our AI writing assessment may not always be accurate (i.e., our AI models 
may produce either false positive results or false negative results), so it should not be used as the sole basis for adverse actions against a student. It takes further scrutiny and human 
judgment in conjunction with an organization's application of its specific academic policies to determine whether any academic misconduct has occurred.

Frequently Asked Questions

How should I interpret Turnitin's AI writing percentage and false positives?
The percentage shown in the AI writing report is the amount of qualifying text within the submission that Turnitin’s AI writing 
detection model determines was either likely AI-generated text from a large-language model or likely AI-generated text that was 
likely revised using an AI paraphrase tool or word spinner.
 
False positives (incorrectly flagging human-written text as AI-generated) are a possibility in AI models.
 
AI detection scores under 20%, which we do not surface in new reports, have a higher likelihood of false positives. To reduce the 
likelihood of misinterpretation, no score or highlights are attributed and are indicated with an asterisk in the report (*%).
 
The AI writing percentage should not be the sole basis to determine whether misconduct has occurred. The reviewer/instructor 
should use the percentage as a means to start a formative conversation with their student and/or use it to examine the submitted 
assignment in accordance with their school's policies.

What does 'qualifying text' mean?
Our model only processes qualifying text in the form of long-form writing. Long-form writing means individual sentences contained in paragraphs that make up a 
longer piece of written work, such as an essay, a dissertation, or an article, etc. Qualifying text that has been determined to be likely AI-generated will be 
highlighted in cyan in the submission, and likely AI-generated and then likely AI-paraphrased will be highlighted purple.
 
Non-qualifying text, such as bullet points, annotated bibliographies, etc., will not be processed and can create disparity between the submission highlights and the 
percentage shown.
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Unit 4: Visualization and Editing in Power BI 

 

Learning Outcomes 

1. Understand the concept and importance of data visualization in data analysis. 

2. Identify and describe various types of visualizations available in Power BI. 

3. Learn how to format and edit visuals eƯectively to enhance readability and 
impact. 

4. Summarize the key points and best practices related to visualization design. 

5. Familiarize yourself with key terms used in Power BI visualizations. 

6. Answer descriptive questions to reinforce understanding of visualization 
techniques. 

7. Apply concepts in a real-world context through a Power BI case study. 

 

 

Content 

4.0 Introductory Caselet 

4.1 What is Data Visualization? 

4.2 Types of Visualizations in Power BI 

4.3 Formatting and Editing Visuals 

4.4 Summary 

4.5 Key Terms 

4.6 Descriptive Questions 

4.7 References 

4.8 Case Study 

  

4.0 Introductory Caselet 

 

“The Numbers That Spoke: A Farmer’s Journey with Power BI” 

Background: 
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It is the semi-rural Nashik in Maharashtra where Meena, 38 years, manages her family 
owned grape farm. For decades she has operated based on gut feeling, old-fashioned 
know-how and weathered notebooks full of weather notes, pesticide logs and yield 
records. But wild weather and fluctuating market prices have made farming harder to 
predict. 

In a visit from her techie nephew, Rishi, a data analyst from Pune, she unburdens 
herself. Rishi listens and opens his laptop before saying: 

“Maasi, imagine if you could talk to your data?” 

Intrigued to learn, Meena observes Rishi who is uploading her written information into 
Excel and importing the file in Power BI. Within minutes, colorful charts pop up: rainfall 
patterns, cost-versus-yield curves, even a map depicting transport times to markets. 

Meena is amazed. She had never seen her farm before. The charts confirm patterns she 

had suspected but couldn’t prove, such as that pest outbreaks are linked with early 
rains or that price dips come thanks to festival weeks. 

And by the end of the day, Meena gets a dashboard on her phone. It’s easy, but it’s also 
a powerful story. 

“This is the first time I’ve seen my farm as a business,” she says with a smile. 

Critical Thinking Question: 

How can data visualization tools, such as power bi enhance decision making in the 
traditional non tech industry (Agriculture)? 

4.1 What is Data Visualization? 

Data visualization is the representation of data in a visual format — such as charts, 
graphs, and maps — that makes the information easier to understand, analyze, and use 
for decision making. We are visual by nature, and we recognise images far quicker than 
words or numbers. Using visual cues we also might find trends, patterns and 
relationships between factors not clearly visible on the raw data alone. 

4.1.1 Concept of Data Visualization 

The notion of data visualization corresponds to the operation of graphically 
representing numerical or qualitative information. It can be as basic as a bar chart with 
monthly sales, or one of those multi-visual dashboards that displays financials, 
operations and customer information. 

The aim is to improve access to large or complex data sets. Rather than sift through 
pages of digits 

in a spreadsheet, users can quickly scan and see what’s going on in visuals. 
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For example: 

• A line graph can be used to track sales over time. 

•A pie chart can illustrate the relative size of each share that competitors have in a 
given market. 

• A map can indicate where customers are. 

Visualization can help turn data into a “narrative” that people can comprehend and use 
to change the world. 

4.1.2 Why Visualization is Important in Decision-Making 

The ability to understand and interpret data is crucial for sound business decisions. 
Raw data — spreadsheets full of numbers, say — can be dense and impenetrable and 
interpreting it, when possible at all, isn’t easy or quick. 

Visualization simplifies this by: 

• Taking a long view: By plotting numbers on an xy axis, a graph can reveal instantly 
whether sales are trending up or down. 

• Patterns emerge: A heatmap could indicate that there’s the most traƯic on weekends. 

• Spotting outliers: A scatter plot may turn up a product that is doing worse, or much 
better, than others. 

By minimizing cognitive load (the mental eƯort of thinking) and making us see, they 
help us make decisions with more insight, assess how we’re doing, and act more 
quickly. This speed and clarity can be a competitive advantage in fast-paced business 
settings. 

4.1.3 Power BI and the Transformation of Raw Data into Visual Insights 

Power BI is a business analytics service created by Microsoft. It supports connections 
to multiple data sources, and enables users to filter and transform it before displaying 
the result in a variety of visuals. 

Here’s how Power BI helps: 

• Data connection: Power BI uses to data from excel files, databases, cloud services 
and many more. 

• Data wrangling: It cleans and organizes raw data — deduplicating, formatting 
columns, joining up datasets. 

• Visualization: With a few clicks, users can generate charts, tables and maps. 

• Dashboards: A number of visuals can be added to an interactive for dashboards. 
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• Interactivity: Power BI makes data exploration filterable, drill-down able and 
discoverable by having your users click directly on visualizations. 

What's great about Power BI is that you don't need to be technical or have no-code/low 
code experience in building professional reports. 

Did You Know? 

Power BI is built on a product known as VertiPaq—A specialized in-memory columnar 
storage engine that can compress the data to such an extent that even if it runs into 
millions of rows, your calculations will still be blazing fast. This engine is what allows 
Power BI to oƯer you real-time dashboards and calculate the aggregate on complex 
measures without aƯecting the performances. 

4.1.4 Business Impact of Interactive Visualizations 

To put it more precisely, interactive visualizations are not simply pictures. They react to 
user input, so people can investigate data in real-time. The conversation makes people 
more engaged with, more understanding of and them more active in the world. 

In business, the impact includes: 

• Quicker decisions: Interactive graphics enable users to sift and search data in the 
blink of an eye. 

• Mental maps: AIDEO allows users to “drill down” through visuals for alternative views 
of data. 

• Personalized views: Stakeholders can tailor the visuals to emphasize what matters 
most to them. 

• Community: Dashboards can be shared with other teams, fostering conversation and 
mutual understanding. 

For instance, a sales manager could click on one region in a map to examine product 
performance only in that area, or a finance oƯicer might filter out any time data for 
revenue in the last quarter. 

User every interaction By giving users powerful and dynamic tools, interactive 
visualizations help businesses become more data-driven and adaptive. 

 

4.2 Visualization Types within Power BI 

Power BI has lots of features that enhance the capabilities to take action what users 
want with their data & tell them an eƯective story. Each type of visual is suitable for 
diƯerent purposes; some are best to compare data, others are good to show trend, and 
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the others are good to summarize the metric. You'll want to select the best visual for 
your data, which depends on the type of data and message you’re specifying. 

4.2.1 Simple visuals: Bar, Column, Line, Pie, Donut, Table and Matrix 

Here are the most popular visuals that work for basic data analysis. 

• Bar Chart: The data are shown with horizontal bars. Useful for comparisons of 
categories to each other (e.g. product sales). 

• Column Chart: The same, but with vertical bars. Generally utilized for visualizing 
time-ordered data. 

• Line Charge: Plots lines to connect the data points. It's great for showing trends over 
time (revenue by month, for example). 

• Pie Chart: Represents the data slices of a circle. Refer to parts of a whole (market 
share, etc.) 

• Donut Chart: Just like a pie chart, except there’s a hole in the center. Frequently used 
as esthetic or design considerations. 

• Table: Displays data in rows and columns, such as you would see in Excel. Good for 
detailed or tabular data. 

• Matrix: Similar to a table, but it can be grouped by more than one category. Frequently 
used for cross-tab reports (like sales by region and product). 

4.2.2 Comparison Visuals: Stacked vs Clustered, Waterfall, and Funnel The next three 
visualizations (see Figure 1 below) are comparative charts; stacked versus clustered 
bar charts29, a waterfall chart30ÿ, and a funnel chart31ÿ. 

These visuals are great when you want to compare the data across groups or 
demonstrate how values accumulate, or decrease, over time. 

• Bar/Column Chart Stacked: Representation of the sum several sub-categories 
stacked in one bar. It has the added benefit of visualizing contributions, both total and 
individual. 

• Clustered Column/Bar Chart: Places bars next to one another, making it easy to 
compare subcategories. 

• Waterfall Chart: Shows how an initial value grows or diminishes through a sequence of 
intermediate values (e.g., profit analysis starting from revenue, down into costs and 
expenses). 

• Funnel Chart: It is utilized to visualize various stages of one process (i.e. sales 
pipeline). Every step is displayed as a smaller segment. 
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4.2.3 Trend & Distribution Graph: Line, Are a, Scatter and Histogram 

These visualisations make patterns, trends and data distribution easy to spot. 

• Line: This is appropriate for depicting continuous trends over a period. Have the 
ability to show multiple rows comparing against each other. 

• Area Chart: A type of line chart in which the area under the line is filled with color. 
Great for presenting data cumulatively or in volume. 

• Scatter plot: Shows an individual data point using two numeric variables. Great for 
discovering correlations or patterns. 

• Histogram: Categorises data into ranges (or bins) and presents the volume of values 
in each range. Helps analyze distribution and frequency. 

Instruction to Students: 

You have a subset of monthly revenue data for months January - December for 3 
product categories: Electronics,Apparel and Groceries. Step1: Import the dataset to 
Power BI. Create two visuals: 

A Line Chart that visualizes category-wise month-on-month trend of revenue. 

Area Chart with same data to compare. 

See the diƯerence between cumulative and individual performance in the charts. Take 
a screenshot of both and post it, with a short reflection about which chart says more 
about the two performances—and why. 

4.2.4 KPIs & Summary Visuals: Cards, Gauges, KPI-Visuals 

These images oƯer a fast glimpse of performance measures. 

• Card: Shows one number, for example total revenue or customers. Simple and direct. 

• Multi-Row Card: Displays several numbers in a condensed way. 

• Gauge: Shows a performance comparing to target in speedometer s type. 

• KPI Visual: Compares actual performance to a target, with diƯerences shown by 
colors or symbols. Good for tracking goals. 

4.2.5 Geo Visuals: Maps 

These graphics assist in visualization of data along with its geolocation. 

• Map (Basic Map): Geoplots data points on a world map based on locations such as 
City, Country or Region. 
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• Filled Map: Shades entire regions (countries, states) based on data values (for 
example, sales by region). 

• Shape Map: You can fill custom geographic or non-geographic shapes by values. 

• ArcGIS Map: A richer map experience with more robust geographic data and layers, 
perfect for location-based analysis. 

Power BI allow integration of Advanced Geospatial analytics using ArcGIS Maps, that 
include Heat zones, Drive time areas and demographic overlay. This feature is powered 
by Esri and can go well beyond simply dropping locations onto a map — organizations 
like urban planners, environmental scientists, logistics companies run high-level 
spatial analysis. 

4.3 Formatting and Editing Visuals 

Making visualizations is just the first step in data storytelling. To ensure your visuals are 
professional and make an impact, in Power BI you can format and customize almost 
every element of a visual. This involves how you switch between chart types, define 
axes and labels, select colors and themes etc. 

4.3.1 Changing Chart Types and Customizing Visual Selection 

You can also easily make a type or create it more understandable when you added a 
visual to power bi. 

• Changing Chart Types: 

If you choose a visual, you can then change it to a diƯerent type (e.g. column chart to 
line chart) by selecting another visual from the “Visualizations” pane. This is nice to 
have when you want to experiment with diƯerent formats in search for the one that best 
shares your data. 

• Customizing Visuals: 

Each type of visualization has various formatting options. For example, you can change 
the fields of data that's being used (e.g., add many series), use visual-level filters, and 
sort the values. 

ascending or descending order. The customization panel also allows you to switch on 
or oƯ of certain parts of the chart’s visual, such as legend, label or tooltip. 

• Best Practice: 

Select the visual type according to the story you’d like to serve up. If you are going to 
compare items, use bar or column charts. For trends, use line charts. 

4.3.2 Editing X&Y Axes, Enable/Add Data Labels, Legends and Titles 
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To enhance the readability and the meaning of visuals, Power BI enables you to format: 

• X & Y Axes: 

You can alternate the scale, minimum/maximum values and units (e.g. thousands of, 
millions). You can also rename the axis titles to something more descriptive and choose 
whether or not they will be displayed. 

• Data Labels: 

This makes the real values appear on the chart (e.g., numbers above bars or points on a 
line). They assist users in reading out actual numbers, without the need of hovering or 
guessing. 

• Legends: 

Legends describe what each color or line means in the visual (probably diƯerent 
regions or product categories). You have the ability to position legends at the Top, 
Bottom, Left or Right of the visual; or hide them, altogether. 

• Titles: 

Including a clear, informative title allows users to quickly get introduced to what the 
graphic is doing. You get options to edit the title font size and alignment. 

• Best Practice: 

Utilize basic, legible fonts and try to keep the names short yet informative. Don't add 

too many labels or decorations to your visual. 

4.3.3 Formatting Colors, Themes, and Backgrounds 

Dashboards and reports need to look good, especially when sharing with others. 

• Colors: 

You can customize the color of bars, lines and points to fit your branding or emphasize 
important data values. Similarly, conditional formatting may be applied to give values in 
color (i.e., red for negative growth). 

• Themes: 

Power BI has built-in themes which are groups of colors, fonts and visual elements that 
all have the same aesthetic. You can also import custom JSON themes for full visual 
control. 

• Backgrounds and Borders: 
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You can give visuals backgrounds or borders to make them stand out from others on 
the same report page. You can also play around with transparency to help the visuals 
stand out or blend into the background. 

• Best Practice: 

Use the same color for the same categories across visuals. Don’t rely on too many 
bright or rumbling-colored hues which carry along the potential of overshadowing the 
information. 

4.3.4 Adding Conditional Formatting (Heat Maps, Color by Rules) 

Conditional formatting is a property of Power BI, which uses to represent the data in 
the form of visuals. It allows to automatically point out important trends or outliers. 

• Heat Maps as Tables or Matrices:semicolon \( • \) Heatmaps in the form of table or 
matrix period; Url: —/docs/wikis/Using-Thirdparty-Packages. 

Power BI supports the use of color gradients on your cells according to their values. For 
instance, more sales could be shaded in darker green, while fewer could be shaded in 
lighter green or even red. This helps users quickly see extremes and patterns without 
reading every number. 

• Color by Rules: 

You can set certain rules to assign color according to a condition. For example: 

o If profit margin is > 20%, then green color bar. 

o If the sales value is < ₹1,00,000 then it should be red. 

• How to Apply: 

Choose a visual such as table, bar chart → go to “Format” pane → choose related field 

under Data colors or Conditional formatting → apply rules or gradient. 

• Use Case: 

Conditional formatting is particularly valuable in use-cases of dashboards, where end-
users have to refer to performance reports, their targets or exceptions rather than 
require the users to land at detailed level every time. 

“Exercise: Making Sales Performance Stand Out Using Conditional Formatting” 

Instruction to Students: 

You are provided with a dataset which consists of the monthly sales data of five 
products as follows: Data - product.csv region –cluster. Import the dataset to Power BI 
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and create a Matrix visual having products on rows, regions on columns and values 
being sum of sales. Format the sales amounts to be conditional on: 

• High performing cells (over ₹50,000) are highlighted in green 

• Medium-performing cells (₹30,000-₹50,000) are in yellow 

• Red shows low performing cells (below ₹30,000) 

Export the report to PDF  or share the PowerBI link. Provide a brief interpretation of the 
heatmap (i.e., which countries and products deserve special attention). 

4.3.5 Sorting and Arranging Visuals for Clarity 

A well-laid out report is easier to read and interpret. To keep the report page simple and 
organized, Power BI oƯers sorting and layout options. 

• Sorting Visuals: 

Here’s how to rank bars, columns, or other visuals by: 

o Product names (alphabetical) NOTE: Your work exhibits an alphabetical order 
sequence but the sequence is inconsistent compared to other lists in the document. 

o Quantitative (e.g. from sales figures, the highest to lowest) 

o Custom sort order (e.g., months sorted from Jan to Dec) Sorting makes it easier for 
readers to see which sections are best- or worst-performing. 

• Arranging Visuals: 

Correct line spacing and formatting make the report appear professional. 

o Use both grid lines/ snapping-to-grid to position graphics evenly. 

o Group alike visuals for contextualization (e.g., put sales charts next to profit charts). 

o Utilize white space to minimize clutter and distinguish sections. 

• Best Practice: 

Arrange visual in a left to right top to bottom (like people read) order. Top or center for 
key KPIs. 

4.3.6 Managing Multiple Visuals: Align, Group, Layer Order 

Whether working with a few visuals or many on the same page, arranging them is an 
important aspect of design and usability. 

• Align: 
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Choose several visuals and align their tops, bottoms, centers, or sides using the Align 
tool. This improves symmetry and professionalism. 

• Group: 

Grouping provides a way of grouping multiple visuals to act as one. If you ever group 
them, it allows you to move and resize without messing up grouped layout. This is 
helpful for dashboards that have sections (e.g., a revenue section with 3 visuals). 

• Layer Order (Z-order): 

Power BI visuals can also overlap. Z-Order The stacking order of where one visual 
appears with respect to another visual. For example: 

o Send a backround image to the background 

o A KPI card to be brought in the front o And it must be visible completely. 

• Use Case: 

These layout tools are important in creating involved dashboards with interactive 
controls, images and multiple charts. They help to keep all of that clean, in order and 
readable. 

Knowledge Check 1 

Choose The correct Options : 

Q1. What is one of the primary advantages of data visualization for business analysis 
and decision-making? 

A) It hides unnecessary information 

B) Report file sizes are smaller. 

C) By which, the user can easily find patterns and trends. 

D) It restricts access to important data 

Q2. Why interactive dashboards is better than static reports? 

It certainly takes less time to design them A) 

B) They enable users to dynamically navigate data 

C) They have less charts and graphics 

D) They are easier to print 

Q3. Which type of graph is most appropriate for displaying how a starting value 
fluctuates because of gains and losses? 
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A) Pie Chart 

B) Funnel Chart 

C) Waterfall Chart 

D) Line Chart 

Q4. Why would you use data labels in a chart? 

A) To put a frame around an image 

B) To show the precise number on the chart permanently 

C) To hide axis titles 

D) To filter the data set 

Q5. What can you do with conditional formatting? 

A) Add new data sources 

B) Visually encode based on a data value 

C) Create separate dashboards 

D) Import Excel files 

 

4.4 Summary 

 In this unit, we have focused on introduction and hands-on of Power BI data 
visualization. We started with a definition and explanation of what data visualization is, 
why it's important, and how it is useful in data analysis for decision making. Next, we 
looked at the diƯerent types of visuals Power BI has to oƯer from a simple bar chart to a 
complex geographical map. The next thing we recorded was an in-depth examination of 
how visuals could be formatted and customized to provide more insight and make a 
stronger impact. 

 Good visualisation doesn’t just make data easier to read, it exposes patterns and 
trends in the information. When a user understand how to manage the formatting of 
visuals, conditional formatting and lay them out appropriately on a report page they can 
deliver eƯective interactive dashboards to drive business decisions. The flexibility of 
Power BI makes it possible for all users, regardless of technical expertise, to create 
visually stunning reports that tell a compelling data story. 

 

4.5 Key Terms 
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• Data Visualisation: The representation of information in graphical form, such as 
charts, graphs and maps. 

• Power BI: A Microsoft tool for business analytics that provides data modeling, 
reporting and visualizations. 

Chart Type The particular form of data graphic such as bar chart, pie chart, line chart, 
etc. 

• Axis: In a chart, the line that specifies how a set of values is plotted (X for category, Y 
for value). 

• Legend: A key that indicates the significance of colors, symbols or patterns in a chart. 

• Conditional Formatting: Data-driven rules that alter how visuals look. 

• Dashboard: A group of raised visuals all on one page for analyzing and monitoring 
data. 

• KPI (key performance indicator): a measure of the success of an activity or an 
organization. 

• Slicer: A visual filter in the report that is used to filter what data is displayed on one or 
more other visuals. 

• Theme: A collection of visual formatting options that are applied globally to an entire 
Power BI report. 

 

4.6 Descriptive Questions 

1. What is the meaning of data visualization and its importance in business 
intelligence? 

2. Explain 3 types of basic visuals in Power BI. 
3. What are the advantages of Powerbi in transforming data into useful data? 
4. What is the distinction between a stacked column chart and a clustered column 

chart? 
5. Discuss how showing data in context can be leveraged to improve 

understanding of the data. 
6. In what way does images sorting and alignment help to have a clear PowerBI 

report? 
7. What Is KPI Visualization And How Do They Apply For Performance Monitoring? 
8. What is Power BI's impact on interactive visual analysis and how is it user 

driven? 
9. Why use geographical visuals such as maps in Power BI? 
10. Name and describe three formatting choices within Power BI to tailor visuals? 
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Correct Answers For Knowledge Check 1: 

C) It helps users quickly identify patterns and trends 

B) They allow users to explore data dynamically 

C) Waterfall Chart 

B) To display exact numeric values directly on the chart 

B) Change visual appearance based on specific data values 
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*% detected as AI
AI detection includes the possibility of false positives. Although some text in 
this submission is likely AI generated, scores below the 20% threshold are not 
surfaced because they have a higher likelihood of false positives.

Caution: Review required.

It is essential to understand the limitations of AI detection before making decisions 
about a student’s work. We encourage you to learn more about Turnitin’s AI detection 
capabilities before using the tool.

Disclaimer
Our AI writing assessment is designed to help educators identify text that might be prepared by a generative AI tool. Our AI writing assessment may not always be accurate (i.e., our AI models 
may produce either false positive results or false negative results), so it should not be used as the sole basis for adverse actions against a student. It takes further scrutiny and human 
judgment in conjunction with an organization's application of its specific academic policies to determine whether any academic misconduct has occurred.

Frequently Asked Questions

How should I interpret Turnitin's AI writing percentage and false positives?
The percentage shown in the AI writing report is the amount of qualifying text within the submission that Turnitin’s AI writing 
detection model determines was either likely AI-generated text from a large-language model or likely AI-generated text that was 
likely revised using an AI paraphrase tool or word spinner.
 
False positives (incorrectly flagging human-written text as AI-generated) are a possibility in AI models.
 
AI detection scores under 20%, which we do not surface in new reports, have a higher likelihood of false positives. To reduce the 
likelihood of misinterpretation, no score or highlights are attributed and are indicated with an asterisk in the report (*%).
 
The AI writing percentage should not be the sole basis to determine whether misconduct has occurred. The reviewer/instructor 
should use the percentage as a means to start a formative conversation with their student and/or use it to examine the submitted 
assignment in accordance with their school's policies.

What does 'qualifying text' mean?
Our model only processes qualifying text in the form of long-form writing. Long-form writing means individual sentences contained in paragraphs that make up a 
longer piece of written work, such as an essay, a dissertation, or an article, etc. Qualifying text that has been determined to be likely AI-generated will be 
highlighted in cyan in the submission, and likely AI-generated and then likely AI-paraphrased will be highlighted purple.
 
Non-qualifying text, such as bullet points, annotated bibliographies, etc., will not be processed and can create disparity between the submission highlights and the 
percentage shown.
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Unit 5: Advanced Analytics and Collaboration 

 

 

Learning Outcomes 

1. Understand the role of DAX in performing advanced calculations within Power BI. 

2. Apply the CALCULATE function to modify and control filter contexts. 

3. Use ALL, ALLEXCEPT, and REMOVEFILTERS to manage and override filters eƯectively. 

4. DiƯerentiate between row context and filter context in DAX calculations. 

5. Implement iterator functions like SUMX, AVERAGEX, and RANKX for row-by-row analysis. 

6. Develop business-focused measures such as percentages, rankings, and time intelligence using DAX. 

7. Analyse real-world business scenarios through case studies using advanced DAX techniques. 

 

 

 

Content 

5.0 Introductory Caselet 

5.1 Using DAX for Advanced Calculations 

5.2 CALCULATE – The Most Important DAX Function 

5.3 ALL, ALLEXCEPT, REMOVEFILTERS 

5.4 Iterator Functions (SUMX, AVERAGEX, RANKX) 

5.5 Summary 

5.6 Key Terms 
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5.7 Descriptive Questions 

5.8 References 

5.9 Case Study 

  

5.0 Introductory Caselet 

 

“Numbers Beyond the Ledger: A Manager’s Predicament” 

Background: 

At the Mumbai base of Orion Retail Ltd., a 34-year-old sales manager Meera, fights to save herself from her 

monthly performance review. The business has been expanding quickly, and growth means a deluge of data — 

daily sales transactions, customer feedback logs, regional marketing spend. 

Her Excel reports that used to be good enough now seem clunky and old. Pivot tables take ages themselves and 

coming up with simple percentage growths when you are looking at millions of rows of transactional data can be 

a nightmare. The CFO wants deeper insights: What specific product lines are driving repeat purchases? How 

does Sales Growth vary across the regions after controlling for the Marketing Spend? 

Frustrated, Meera goes for a weekend workshop on Power BI. She encounters DAX (Data Analysis 

Expressions)— a “formulic” language which has the ability to create advanced measures such as YTD Sales, 

Moving Averages, Profit Margins and even churn rates of customers. 

Meanwhile, Meera puts DAX to work as she begins building a dashboard. All of a sudden, the data comes to life: 

A line graph pretty clearly demonstrates that North Zone sales only declined when marketing spend was cut, 

and churn calculations make clear that electronics buyers are less loyal than grocery shoppers. 

The numbers are the same — but it’s in the mind’s eye how they’re seen that has changed. For Meera, DAX 

transforms raw numbers into a story of causes, patterns, and choices. 

Critical Thinking Question: 
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In an era of modern analytics, how should managers reconcile their old fashioned business intuition against the 

insights gleaned through such a tool as DAX? 

5.1 Using DAX for Advanced Calculations 

Power BI is a powerful business intelligence tool that allows organisations to connect to their data, clean it, and 

visualise it for informed decision-making. While it is possible to build simple reports using only basic formulas, 

most business leaders will require more advanced calculations when working with modern datasets. For 

example, year-to-date totals, rolling averages, customer retention rates, or profit margins can hardly be 

computed with a classic sum function. That is why DAX is crucial in Power BI. DAX is a formula language created 

for data modelling in Power BI, Excel Power Pivot, and Analysis Services.  

5.1.1 Importance of Advanced DAX in Power BI 

In appearance, it is quite similar to the formulas in Excel. However, in reality, it is much more powerful – DAX can 

work with large datasets, relational models, and dynamic filters. Power BI helps analysts and managers go 

beyond simple totals and averages. They can create calculated columns, measures, and tables that 

automatically adjust based on various filters and slicers. As a result, Power BI transforms raw data into 

meaningful business insights. Basic DAX is capable of basic arithmetic, such as summing the values from two 

columns or calculating the average. In practice, however, business data is more complex. Managers need to be 

able to calculate answers to questions such as: Builders can also add text, such as bullet points, to improve the 

readability of their text by highlighting the key concepts: • How much revenue was generated this year fully up to 

the present month? • What is the sales three-month moving average? • What percentage of revenue is 

contributed by a particular category of products? • Which customers would you not buy from again next year? . 

Advanced DAX functions allow analysts to answer such questions directly in Power BI dashboards. Some 

important applications where advanced DAX is useful include: 1. Time Intelligence Calculations. Businesses 

often need to compare performance over diƯerent time periods. DAX functions like TOTALYTD, 

SAMEPERIODLASTYEAR, DATEADD allow calculating the desired values across months, quarters, or years 

directly from filters. 

Dynamic Measures 
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DAX will know to automatically adapt measures, say profit margin or conversion rate, which react dynamically to 

filters. For example, if the user chooses only “North Region”, the DAX measure refreshes automatically to show 

results exclusively for that region. 

Business KPIs 

Metrics like customer retention, revenue growth rates, and sales per employee often involve complex 

calculations across diƯerent tables in the database. The good news is that DAX has everything we need to 

properly perform those calculations. 

Scalability with Large Data 

DAX, in contrast to Excel, doesn’t slow down with millions of rows. It is applicable to the real-world commercial 

datasets. 

In other words advanced DAX leverages Power BI from a reporting tool into a decision support system. 

5.1.2 Context in DAX: Row Context vs Filter Context 

-Row-Context and Filter context(Part 3 ADD measures to columns) Go to the website for more! 

Context is one of the cornerstones of DAX. As we all know, misinterpretation of context while working with a 

formula generally results in errors. Context There are two primary kinds of context: row and filter. 

Row Context 

• Row context means when a table is being evaluated on the current row. 

• When defining a calculated column, DAX time and again evaluates the formula row by row. 

• For example, if you have a sales table with Quantity and Unit Price columns, let’s say Qty * Unit price then; 

neue spalte errichten DECLARE @newColumn varchar(50),@qry varchar(100) SET @newColumn = 'UnitPrice' 

SET @qry = 'ALTER TABLE ' + SCHEMA_NAME(schema_id) + '.xxx ADD '+@newcolumn VARCHAR(MAX 

)+'DECIMAL(18,2);' EXEC (@qry) GO How can I reference this value in another query within the same power 

query scope? 

Total Sales(Qty × Unit Price), which, in DAX, the formula is executed for each individual row. 

• Row context is like the same way as in Excel -- how you apply formulas to all cells of a row in a spreadsheet. 
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Illustration: 

Quantity Unit Price Total Sales (Calculated 

Column) 

10 100 1000 

5 200 1000 

8 150 1200 

 

Here DAX evaluated “Total Sales” for each row (row context was used). 

Filter Context 

• Filter context is the subset of filters that have been applied to data at any given time. 

• It is generated when a user actively uses slicers, filters, or measures in visual. 

• Filter context is not single row like row context; it can impact more than one rows at a time. 

• E.g., a measure Total Revenue = SUM(Sales[Total Sales]) is going to add all sales for all rows, however if you 

have a filter on (e.g. only North Region, or only Q1 2024), the result will change based on this filter. 

Illustration: 

If sales table has 1,000 rows and the report filter is used to display only “North Region,” then the measure 

would. 

sum up only the rows for North. 

Row Context vs Filter Context 

• Row Context: Performs calculations at the row level, it is applied automatically when using calculated 

columns. 

• Filter Context: Acts on dataset level; it's applied when measures are being used along axis with filter, slicer, or 

visual. 

• Advanced DAX requires switching between row context and filter context with tools like CALCULATE. 

Example with CALCULATE: 
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Say we want report to give the total sales for only North Region despite of any report filters. North Sales = 

CALCULATE(SUM(Sales[Total Sales]),Sales[Region] = "North") 

Here CALCULATE modifies the filter context so that we're only looking at results for rows where Region = North. 

Did You Know? 

The calculated column in DAX always works under row context, yet when you enclose it with a CALCULATE 

function the row context could easily convert to a filter context. This is called context transition. That’s one of the 

main reasons that CALCULATE is thought to be so powerful. 

5.2 CALCULATE – The single most important DAX function The CALCULATE is used to change one or multiple 

filter context in a DAX Formula. 

It is commonly said that CALCULATE is the most important function in DAX because it allows you to modify the 

filter context. Although rudimentary measures such as SUM or AVERAGE can be used with actual filters, with 

CALCULATE you can manipulate, replace and discard filters at runtime. 

Business-wise, CALCULATE allows you to solve complicated questions like: 

• “How much are the sales in the north region?” 

• “How much was the profit this year vs. last year?” 

• “How much of revenues are sourced from a particular product category?” 

Without CALCULATE, we could not analyze leads so specifically. 

5.2.1 Syntax and Usage of CALCULATE Syntax your square brackets be opened: 

CALCULATE(, , , …) 

• : Calculation to be carried out (ex: SUM, AVERAGE, COUNT). 

• ,  …: Zero or more arguments that adjusts the filter context. 

Basic Usage Example: 

Total Sales North = CALCULATE(SUM(Sales[Revenue]), Sales[Region] = "North") Example Measure that refers to 

aggregated value: Total-Sales-North Customer is looking for a calculated measure which gives the total sales 

values for all the Regions. 
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•The expression is SUM(Sales[Revenue]) (the sum of atll revenue). 

• The filter limits it to rows where Region = North. 

The outcome will always be restricted to North sales disregard the fact that a report filter says all regions. 

Did You Know? 

Yes CALCULATE is the only DAX function that can change the filter context. Other functions may add new 

values to modify the filter context, only CALCULATE can change the way existing filters are applied, enabling 

application of custom conditions even when report slicers seem to contradict. 

5.2.2 Applying Filters Inside CALCULATE 

Within CALCULATE, filters can be referenced in a variety of ways: 

Column Filters (Simple Conditions) 

Example: 

CALCULATE(SUM(Sales[Revenue]), Sales[Product] = "Laptop") 

→ Revenue will only be given for Laptop purchase. 

Multiple Filters 

Example: 

CALCULATE(SUM(Sales[Revenue], Sales[Region] = "North", Sales[Year] = 2024) 

→ Returns Revenue just for the North Region in 2024. 

Using Filter Functions 

DAX allows advanced filter expressions: 

Example: 

o FILTER – Filter an entire table. 

o ALL – Remove existing filters. 

o ALLEXCEPT – Retain some, not all 
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CALCULATE(SUM(Sales[Revenue]), FILTER(Sales, Sales[Revenue] > 50000)) 

→ Adds only those sales where the transaction is of more than ₹50,000. 

5.2.3 Practical Examples of CALCULATE in Business Reports 

Regional Sales Calculation 

North Sales = CALCULATE(SUM(Sales[Revenue]), Sales[Region] = "North") Et voilà, Problem solved ͧͪͩͨ ΠΡ΢ΣΤ ⊓⊔⊕⊖⊗⊘⊙ 

See,It is very simple.You have applied Filter Context over the Static Text value (which forms a Pattern). 

→It would be useful for mngrs to see performance by N v S vs W regions. 

Year-to-Date (YTD) Sales 

Sales YTD = CALCULATE(SUM(Sales[Revenue]), DATESYTD(Calendar[Date])) 

→ Keeps track of overall sales from the beginning of the year to current date. 

Category Contribution 

Your Laptop Sales % = DIVIDE(CALCULATE(SUM(Sales[Revenue]), Sales[Product] = "Laptop"), 

SUM(xSales[Revenue])) 

→ Displays the proportion of Total Revenue sourced from Laptops. 

Customer Retention 

Customers Who Have Made More Than One Purchase = CALCULATE(DISTINCTCOUNT(Sales[CustomerID]), 

FILTER(Sales, Sales[PurchaseCount] > 1)) 

→ Counts repeat purchasing customers,ideal for looking at loyalty. 

5.2.4 Common Mistakes and Best Practices with CALCULATE 

 Common Mistakes 

Mistaking Row Context for Filter Context. 

o CALCULATE acts on filter context not just each row. 

o Poeple who are new to this 'think' or want it to be done row by row, which will be wrong. 
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Not using ALL when necessary 

o If you want to calculate a percentage against the total, sometimes you have to clear filters. 

o If we do not include ALL, the report might run only for the current filter category. Example mistake: 

the Product % = the SUM(Sales[Revenue]) / the SUM(Sales[Revenue]) 

→ This will always return 1 as filters are not being reset. 

Correct way: 

Product % =DIVIDE(SUM(Sales[Revenue]), CALCULATE(SUM(Sales[Revenue]),ALL(Sales[Product]))) 

Overcomplicating Filters 

o And for some cases, a basic column filter is all you need. FILTER, when used without need makes codes 

slow. 

Best Practices: 

• Never have totals and KPIs as calculated columns – CALCULATE works best with measures. 

• You can use named measures inside CALCULATE for better readability. 

• Make sure the instructions are clear when filters should be added, removed, or bypassed. 

• Step through test CALCULATE results on simpler queries before moving to more complex ones. 

 

Instruction to Student: 

Open a data set of sales (regionwise) for three regions (North, South and West). Create two measures in Power 

BI: 

Entire Revenue (Aggregate of All Income). 

Product % of Total = DIVIDE(SUM(Sales[Revenue]), CALCULATE(SUM(Sales[Revenue]), ALL(Sales[Product]))) 

Apply a slicer on Region. What happens to the percentage contribution of each product when you filter? 

to a single region. Turn in a brief explanation for why you had to write ALL in the denominator. 
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5.3.2 Using ALLEXCEPT to Keep Specific Filters  

ALLEXCEPT: This function removes all filters except the ones you enumerate. Perfect if you want totals or 

calculations for one or more dimensions, but not others. 

Syntax: 

ALLEXCEPT(, , , …) 

Business Example: 

A business would like to get a measure where total sales are calculated per region even when additional slicers 

(like Sales person, product etc..) are applied except that of the Region once. 

Region Sales =CALCULATE(SUM(Sales[Revenue]), ALLEXCEPT(Sales,Sales[Region])) 

• This makes sure that filters such as “Product =Laptop” are not considered. 

• The output is the total sales for each region independent of product. This is very handy when you're creating 

regional market share reports. 

5.3.3 REMOVEFILTERS Function – Purposes and Use-cases  

The intention of this function is to clear all the filters which have been applied on a table or ALL on the model for 

that matter. 

REMOVEFILTERS clears filters just like ALL does, but is more explicit and preferred for readability. It tells Power 

BI to not consider filters on a certain column or table. 

Syntax: 

REMOVEFILTERS() 

Business Example: 

We want to compute company revenue, no matter what filters (region, product or year) are applied. Company 

Sales = CALCULATE(SUM(Sales[Revenue]), REMOVEFILTERS(Sales)) 

REMOVEFILTERS, however does not bring back the unfiltered column/table it only clears out any filters for the 

calculation. Like if my intent is to say, “just ignore filters,” as opposed to also saying, “return all the values.” 
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5.3.4 Comparative Analysis with ALL, ALLEXCEPT, REMOVEFILTERS 

 

Key Insight: 

• Use ALL when you intend for the denominator to be all the records (e.g., percentages). 

• Use ALL EXCEPT if you want to leave a filter context for one or more dimensions. 

• REMOVEFILTERS when wanting a cleaner syntax if only ignoring filters is needed. 

5.4 Iterator Functions (SUMX, AVERAGEX, RANKX) 

Iterator functions – these are special kinds of functions that take each row -one by one- from the table we pass 

to it and perform calculatons on the values in the row, finally aggregating those whch can be calculated over a 

number of rows into a final value. 

In contrast to simple aggregates (such as SUM or AVERAGE), iterators can provide greater flexibility, because 

they calculate an expression for each row independently before summarizing the results. 

Function What It Does When to Use Example Use Case 

ALL Removes all filters from a 

table or column 

When you want

 to compare  a  

part  to  the 

whole (like % of total) 

Product sales as % of 

company total 

ALLEXCEPT Removes all filters except 

the specified ones 

When you want totals 

by 

specific dimensions

 but ignore 

others 

Region-wise total sales, 

ignoring product 

REMOVEFILTERS Clears filters but keeps 

data 

model intact (does not 

return all rows explicitly) 

When you want clean 

calculations without 

filter influence 

Total sales across all 

products and regions, 

regardless of applied filters 
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Iterator functions are particularly valuable for business analytics because they can be used to derive profits, 

margins, customer averages and rankings that simple aggregators cannot calculate. 

5.4.1 Concept of Iterator Functions in DAX  

• Iterator functions work by establishing a row context (one by one). 

• They calculate for each row a computation (for example, Quantity × Unit Price). 

• They are calculated row-by-row: they don’t sum a column, for example. 

These are quite useful for situations where you want to perform the calculation based on/between several 

columns in a row. 

5.4.2 SUMX – Summation On Row Context – Example: Definition: 

SUMX Returns the sum of an expression evaluated for each row in a table. 

Syntax: 

SUMX(, ) 

Business Example: 

On a retail company side, it wants to get the total Sales Revenue for each transaction (, which is calculated by 

Qty × Unit Price). 

 

Transaction Quantity Unit Price 

T1 10 

 

100 

T2 5 200 

T3 8 150 
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Formula: 

Total Revenue = SUMX(Sales, Sales[Quantity] * Sales[Unit Price]) Result: 

• T1: 10 × 100 = 1000 

• T2: 5 × 200 = 1000 

• T3: 8 × 150 = 1200 

• Total Revenue = 3200 Why  SUMX? 

If we used just SUM(Sales[Quantity]) * SUM(Sales[Unit Price]), the result would be 

wrong because it multiplies totals, not row-level values. 

 

Instruction to Student: 

Suppose you have the following dataset:Product Quantity Unit Price 

Discount% 

Add new measure Use SUMX and calculate Net Revenue as (QuantityUnit 

Price(1Discount)(Cost))/ Cost)/DISTINCT(table[Date])). 

Discount%)). 

Compare this to the result when Revenue is already a column in the data. 

Write a short description of why SUMX is more accurate or flexible than a 

SUM in this particular situation. 

5.4.3 AVERAGEX – Calculating Average Across a Table  

AVERAGEX returns the average of an expression evaluated for each row in a 

table. 

Syntax: 

AVERAGEX(, ) 

Business Example: 

A company would like to calculate Average revenue per transaction (QTY × 

Unit Price). Formula: 

Avg Revenue per Transaction = AVERAGEX(Sales, Sales[Quantity] * Sales[Unit 

Price]) With the dataset above if I do: 

• Transaction Revenues: 1000, 1000, 1200 

• the average of costs = (1000 + 1000 + 1200) ÷ 3 = 1066.67 

This is a more accurate number than ratio of the total revenue to the number 

of transactions (if filtering or weighting is considered). 
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5.4.4 RANKX – Creating Rankings in Power BI  

The RANKX function returns a ranking of a particular number in the context 

given by using the DAX language. 

RANKX – RANKX returns the ranking of a number in a list of numbers for each 

row in the table argument, based on an expression. 

Syntax: 

RANKX(, , [value], [order], [ties]) 

• : The table you want to compare it to (e.g., a list of products). 

• : Measure to rank on (for example, total revenue). 

• [order] - 0 for descending (default), or 1 for ascending. 

• [ties]: whether to skip or assign the same rank to a group of tied results. 

Business Example: 

Ranking products by revenue. 

 

Product Revenue 

A 50,000 

B 70,000 

C 40,000 

 

Formula: 

Product Rank = RANKX(ALL(Sales[Product]), SUM(Sales[Revenue]), , DESC, 

Skip) Result: 

• Product B → Rank 1 

• Product A → Rank 2 

  

• Product C → Rank 3 

Why RANKX? 

It helps managers quickly identify top-performing products, regions, or 

salespeople. 

 

Knowledge Check 1 

Choose Correct Multiple Choice Questions: 
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Q1. Which of the items below best describes Row Context in DAX? 

A) This occurs when filters are implemented by slicers. 

B) It simultaneously scans the whole dataset – not serial by lineage product. 

C) It is one row at a time, have been done in calculated columns typically. 

D)It has "all" option to ignore filters. 

Q2. What makes CALCULATE the most important DAX function? 

A) New tables are added to the model. 

B) It changes the filter context of a statement. 

C) It does the row context to measures. 

D) It removes duplicate records. 

Q3. You need to work out the Product Sales % of Total Revenue in Power BI. 

What is the DAX formula to be used as denominator? 

A) REMOVEFILTERS(Sales) 

B) ALL(Sales[Product]) 

C) ALLEXCEPT(Sales, Sales[Region]) 

D) DISTINCT(Sales[Product]) 

Q4. A company need to determine Net Revenue = Quantity x Unit Price. What 

DAX function to be used to make it calculate in every line? 

A) SUM 

B) SUMX 

C) AVERAGE 

D) COUNTROWS 

Q5. What if two items have the same amount of revenue, what does RANKX 

do by default when it assigns ranks? 

A) Gave both the products same rank skipping next rank. 

B) Ranks both products tied without any gaps. 

C) Assigns them different random ranks. 

D) Takes one of the products off from the rank. 

5.5 Summary 

 In this chapter, we have discussed about a few key elements of DAX (Data 

Analysis Expressions) in Power BI. 

 Using the advanced DAX, complex business calculations as well year to 
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date sales, moving averages and percentage contributions can be created 

which helps in making the dashboards more informative. 

Most powerful DAX function is CALCULATE, can change filter context to 

give answers on specific business questions. 

 Certain functions such as ALL, ALLEXCEPT and REMOVEFILTERS are useful 

for manipulation of filters control to make sure that comparisons and 

percentage-of-total calculations are correct. 

Iterator functions (SUMX, AVERAGEX, RANKX) allow you to calculate on a row-

by-row basis—how much profit is included in each row of your report? What 

is the weighted average for business partners or products sold? What’s their 

rank against the competition?) Basic aggregators cannot do this. 

 Combining these concepts is what leads to advanced reporting and 

decision-making in Power BI. 

5.6 Key Terms 

• DAX (Data Analysis Expressions): Power BI’s formula language for creating 

complex calculations. 

• CALCULATE: A DAX function that modifies the filter context of a 

calculation. 

• Filter Context: The collection of filters on data when a calculation is 

computed. 

• ALL: Clears filters from columns or tables. 

• ALLEXCEPT: Removes all filters except those in specified columns. 

• REMOVEFILTERS: Clears your filters for cleaner calculations. 

• Iterator Functions: DAX functions like (SUMX, AVERAGEX, RANKX) that 

process row by row evaluation over a table. 

• SUMX: Sums the result of an expression evaluated for each row. 

•AVERAGEX: Returns the average of an expression evaluated for each row 

within a table. 

• RANKX: Ranks the rows in a table by using a measure. 

5.7 Descriptive Questions 

Why advanced DAX is important in Power BI and how it goes beyond basic 
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reporting? 

Describe the concepts of row context and filter based on examples. 

Question 3 Summary data Break down sales by orders at the level of order 

header, detail or some calculated measure Sales for region Specify the 

syntax including any parameters of CALCULATE function Draw an example 

getting sales for a particular region. 

How all function is different from ALLEXCEPT and REMOVEFILTERS? Give 

business-related examples. 

What does it mean by iterator functions in DAX? What is the role of SUMX, 

AVERAGEX and RANKX with examples? 

Why is CALCULATE the most important function in DAX? Discuss with 

scenarios. 

How to apply iterator functions on a business data set to calculate 

Profitability or Rankings? 

5.8 References 

• Microsoft Documentation: DAX Function Reference. Available at: 

https://learn.microsoft.com/en-us/dax 

• Marco Russo & Alberto Ferrari (2019). The Definitive Guide to DAX. 

Microsoft Press. 

• Power BI Community Blogs: https://community.powerbi.com 

• Chris Webb (2014). Power Query for Power BI and Excel. Apress. 

• Practical business case examples adapted from real-world analytics in 

sales and retail sectors. 

 

Answers to Knowledge Check 

Correct Answers for Knowledge Check 1: 

Q1: C) It processes one row at a time, usually in calculated columns. 

Q2: B) It modifies the filter context of an expression. 

Q3: B) ALL(Sales[Product]) 

Q4: B) SUMX 

Q5: A) Assigns both products the same rank and skips the next rank. 
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*% detected as AI
AI detection includes the possibility of false positives. Although some text in 
this submission is likely AI generated, scores below the 20% threshold are not 
surfaced because they have a higher likelihood of false positives.

Caution: Review required.

It is essential to understand the limitations of AI detection before making decisions 
about a student’s work. We encourage you to learn more about Turnitin’s AI detection 
capabilities before using the tool.

Disclaimer
Our AI writing assessment is designed to help educators identify text that might be prepared by a generative AI tool. Our AI writing assessment may not always be accurate (i.e., our AI models 
may produce either false positive results or false negative results), so it should not be used as the sole basis for adverse actions against a student. It takes further scrutiny and human 
judgment in conjunction with an organization's application of its specific academic policies to determine whether any academic misconduct has occurred.

Frequently Asked Questions

How should I interpret Turnitin's AI writing percentage and false positives?
The percentage shown in the AI writing report is the amount of qualifying text within the submission that Turnitin’s AI writing 
detection model determines was either likely AI-generated text from a large-language model or likely AI-generated text that was 
likely revised using an AI paraphrase tool or word spinner.
 
False positives (incorrectly flagging human-written text as AI-generated) are a possibility in AI models.
 
AI detection scores under 20%, which we do not surface in new reports, have a higher likelihood of false positives. To reduce the 
likelihood of misinterpretation, no score or highlights are attributed and are indicated with an asterisk in the report (*%).
 
The AI writing percentage should not be the sole basis to determine whether misconduct has occurred. The reviewer/instructor 
should use the percentage as a means to start a formative conversation with their student and/or use it to examine the submitted 
assignment in accordance with their school's policies.

What does 'qualifying text' mean?
Our model only processes qualifying text in the form of long-form writing. Long-form writing means individual sentences contained in paragraphs that make up a 
longer piece of written work, such as an essay, a dissertation, or an article, etc. Qualifying text that has been determined to be likely AI-generated will be 
highlighted in cyan in the submission, and likely AI-generated and then likely AI-paraphrased will be highlighted purple.
 
Non-qualifying text, such as bullet points, annotated bibliographies, etc., will not be processed and can create disparity between the submission highlights and the 
percentage shown.
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Unit 6: Building Dashboards and Collaboration 

 

Learning Outcomes 

1. Understand the principles of interactive dashboard design and apply techniques 
to create user-friendly, dynamic dashboards that support business decision-making. 

2. Use Power BI features such as slicers, drill-through, and bookmarks to make 
dashboards interactive and adaptable to diƯerent user needs. 

3. Recognise the role of Power BI Service in publishing, sharing, and collaborating 
on reports across an organisation. 

4. Apply best practices for sharing and securing reports, including managing user 
access, workspaces, and permissions. 

5. DiƯerentiate between Power BI Desktop and Power BI Service in terms of their 
purposes, capabilities, and integration in the analytics workflow. 

6. Summarise key concepts of dashboard creation and report sharing, reinforcing 
the use of interactive features for eƯective storytelling with data. 

7. Define and correctly use key terms such as dashboards, slicers, drill-through, 
workspaces, publishing, and report sharing. 

 

 

 

Content 

6.0 Introductory Caselet 

6.1 Developing Interactive Dashboards 

6.2 Introduction to Power BI Service and Sharing Reports 

6.3 Summary 

6.4 Key Terms 

6.5 Descriptive Questions 

6.6 References 

6.7 Case Study 
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6.0 Introductory Caselet 

 

“From Reports to Insights: The Manager’s Dashboard Journey” 

Background: 

Ritika, a marketing manager at NovaTech Electronics, has access to monthly Excel 
reports that include sales performance per country and region, advertising spend by 
type of ad and customer satisfaction per quarter. The reports are comprehensive but 
static, fabricating noise that can make it challenging to extract and recognize trends or 
troubleshoot problem areas. 

In a meeting of leadership, the CEO says: 

• What category of product is growing the fastest this quarter? 

• What is the eƯect of digital advertising on local sales? 

• Are we able to measure customer satisfaction as well as sales growth? 

Ritika has diƯiculty answering these questions in raw as the data is all over the place 
and needs some massaging. 

She is at an in-person Power BI training class and learning how to create interactive 

dashboards. Summarizing sales and marketing data alongside customer commentary 
in a unified view with slicers, charts and KPIs, Ritika builds a dashboard that answers 
questions on the spot. 

Next meeting, rather than flipping through numerous Excel sheets, Ritika clicks on a 
slicer to filter results by region. A line graph changes immediately to show that digital 
ads lifted sales in the North but not in the West. One of the product line has a gauge that 
shows falling satisfaction ratings,and an immediate discussion starts. 

The leadership knows that dashboards are not just charts, but tools for decision 
making. 

Critical Thinking Question: 

In what way can interactive dashboards speed up decision making / improve its quality 
over static reports? 

6.1 Developing Interactive Dashboards 

An interactive dashboard is a visual interface that integrates multiple reports and 
visuals into a single place, providing users with a way to explore data dynamically. 
Unlike reports that are simple and a bit static, dashboards can respond to user actions 
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through filters, slicers, and drill-throughs so users can perform data exploration in an 
intuitive manner. 

Key Features of Interactive Dashboards 

Visualisation diversity : charts, maps, cards and KPIs displaying various types of data. 

Filters and Slicers – Allow your users to filter, by region, time period or product category 

instantly. 

Drill-down and Drill-through – The ability to move from an aggregated view into more 
detailed views (e.g. sales by salesperson) Enable pivoting on your data sets rather than 
just aggregating dimensions! 

Bookmarks and Buttons – Tailor navigation within the dashboard to look more app-like. 

KPIs and Indicators – Focus on business objectives (for example, revenue target vs. 
actuals). 

How to Create an Interactive Dashboard in Power BI 

Step 1: Capture Business Objectives -Define what decisions your dashboard should 
enable (e.g. track sales, analyze costs). 

Prep and Model Data – Clean, format, and interlink your data across tables. 

Choose the right visual – Use a chart or KPIs that tells the story of your data in the best 
way possible. 

Make it Interactive – Try to employ slicers, drill throughs, and filters to create user 
friendly dashboards. 

Design: Clarity - Be Consistent in Colour, Label and Layout. 

Test with End Users – Share drafts of the dashboard with stakeholders to confirm it 
answers business questions. 

Business Example: 

A retail chain implements a live, interactive sales dashboard: 

• Lines on the chart indicate monthly sales pattern. 

• Bar chart is a comparison of revenue by product category. 

• Map visual highlights regional performance. 

• Slicer can filter by quarter or region. 

• KPI card showing YTD revenue vs target. 
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If a manager chooses “South Region,” the whole dashboard changes in real-time to 
display all category sales, 

trends, and consumer ratings in that market only. 

6.1.1 Principles of EƯective Dashboard Design 

A dashboard is of little utility if it cannot communicate insights fast and clear. Great 
design helps users spend less time looking for information, and more making 
decisions. 

Key Principles: 

Less is More – Simplify and make your visuals easy to understand. Avoid unnecessary 
graphics or clutter. 

Prioritization – Keep the most relevant KPIs and visuals at the top or in center where the 
user’s eyes should first see them. 

naturally focus. 

Consistency-Ensure that visuals have a consistent look in colour, type size and format 
based on the colours, fonts and formatting of your organisation’s branding . 

Relevance – Each and every chart ought to address a business question. Remove 
visuals that don’t add 

value. 

Storytelling – Organize the visuals in such way that they tell a coherent story (start with 
an overview, then go into details). Business Application: A sales dashboard’s primary 
focus should be on revenue, profit, and customer trends while relegating detail 
breakdowns (such as profit by product) to secondary visuals. 

6.1.2 Combining Multiple Visuals into a Single Dashboard 

Dashboards are awesome because you can templatize diƯerent views of the same 
data set. Rather than segregated reports, multiple visuals can exist side by side and in 
harmony. 

Common Visuals Used Together: 

• Line Graphs to illustrate trends over time. 

• Bar/Column Charts for category comparisons. 

• Maps for geographic analysis. 

• Pie/Donut Charts for percentage shares. 

• Main tables or Matrix to explodetails. 
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Business Use Case: The following can be a sample use case to display Regional sales 
dashboard. 

• Line chart: Monthly sales trend. 

• Map: Sales by state. 

• Bar chart: Product category performance. 

• Table: The 10 biggest customers by revenue. 

Together they give you a 360-degree view of sales. 

 

“Activity 1 ” 

Instruction to Student: 

Here is the download of a dataset including regional sales, product categories and 
monthly revenue. In Power BI Desktop: 

Develop at least three diƯerent visuals (line chart for monthly sales trends, stacked bar 
chart (or 100% stacked) for product categories, map for regional sales). 

Bring them together in a single dashboard. 

Make sure if Any Region is chosen a map, The other visuals should update. Send us 
what you found, paired with a screenshot of your dashboard and a brief explanation for 
the way in which interactivity allowed you to see new insights rather than viewing each 
chart on its own. 

6.1.3 Using Slicers, Filters, and Drill-Through for Interactivity 

Static dashboards can inhibit users with a large volume of data. Interactivity Keen 

focuses users on what matters most. 

Tools for Interactivity: 

• Slicers: On-screen filters (dropdown menus or buttons) that allow users to select a 
region, year or product category. 

• Filters: Used at report, page, or visual level to limit what information is displayed. 

• Drill-Down: Clicking on a chart element (such as bar) shows finer detail (e.g., sales by 
region → state → city). 

• Drill-Through: When the user right-clicks on a data point, a new page appears and 
shows detailed visuals for that specific point. 
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Business Scenario: In profit dashboard, a slicer is used for filtering by quarter, and 
drillthrough enables the manager with one click to see cost breakdown for a specific 
product line. 

Did You Know? 

In Power BI, slicers do so much more that can only be achieved using numbers or 
categories to filter the data. You can also use hierarchical slicers (for example, Year → 
Quarter → Month) that allow users to slice and dice with more detail as they drill down 
in the same control. 

6.1.4 Adding KPIs, Cards, and Summary Metrics 

Dashboard works best when KPIs are easily visible. That’s what Cards and KPIs are for. 

Types of KPI Visuals: 

• Card Visuals: Displays a single number, e.g. “Total Revenue = ₹5.2 Cr”. 

• KPI Visuals: Show progress against a goal, usually with indicators (green = on target, 
red = below target). 

• Visual Meter: Present the measurement as a dial (e.g., customer satisfaction score). 

Business Example:A dashboard for a retail chain might show: 

• Card: YTD Recurring Revenue = ₹120 Cr 

•KPI: Revenue vs. Target (Target = ₹150 Cr → 80% was achieved) 

• Check: General Customer Satisfaction = 7.8/10 

These give an immediate indication of how things are going with no need for the user to 
interpret complicated graphs. 

6.1.5 Best Practices for Dashboard Layout and Usability 

Even with the right visuals, bad layout can make a dashboard confusing. 

Best Practices: 

Logical Flow – high level metrics at top, drilling in graphics in the middle and supporting 
data down below. 

How You Use Space – Don’t cram things together, use white space to separate. 

Make key KPIs Standout – You have a big number, make it big too! 

Colours - Uniform Use (e.g., green for positive, red for negative). 

Responsive Design - Create dashboards that scale on all screen sizes (desktop, tablet, 
mobile). 
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Limit the Visuals – Don’t go chart crazy on your users. Focus on 6–8 high-impact 
visuals. 

Business Example: The finance dashboard of a CFO is configured so that: 

• Top Line = Key KPIs, which are (Revenue, Expenses, Profit Margin). 

• Middle = Category breakdowns and trend charts. 

• Bottom = Expanded tables for drill-down. 

This way executives are able to scan the dashboard in a matter of seconds and pay 
attention where required. 

Did You Know? 

Studies on visual perception have indicated that people naturally read a dashboard in a 
“Z-pattern” (left- to-right, then top-to-bottom). This includes putting your KPIs in the 
top-left or center for quicker recognition and decision making. 

6.2 Introduction to Power BI Service and Sharing Reports 

Power BI Desktop is utilized for report creation, with the Power BI Service providing a 
cloud-based platform to share and collaborate on reports from anywhere. It allows 
organizations to move beyond the single analysis view, and use dashboards as 
enterprise decision-making tools. 

6.2.1 Overview of Power BI Service (Cloud Platform) 

The Power BI Service is Microsoft’s cloud distribution platform for business 
intelligence. It enables reports and dashboards developed in Power BI Desktop to be: 

• Published online for easy access. 

• Shared with other users securely. 

• Watched on various devices, from web browsers to tablets and smartphones. 

Key Features: 

Workspaces – Group spaces to author, publish and manage reports together. 

Dashboards – Visualizations from multiple reports in a single-page view. 

Apps - Pre-packaged reports and dashboards that you can share with the broader 
community. 

Refresh on a schedule – Refreshes data from connected sources, but automatically. 

Row-Level Security (RLS) – Users see only the data that applies to them. 
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Business Scenario: A retailer is using Power BI Service to allow regional managers see 
their dashboards at all times, with the head oƯice having access to a combined national 
view. 

6.2.2 Publishing Reports from Desktop to Service 

Analysts publish reports to the Service so that they can be shared in the cloud. 

Steps: 

Create and save a report in Power BI Desktop. 

Click Sign in with your Power BI account. 

Click Publish → Workspace in Power BI Service. 

When released, the report can be accessed via the web by authorised users. 

Benefits: 

• Reports become accessible anytime, anywhere. 

• Automated data refreshes (no need for manual updates). 

• Multiple teams can work on the same data set. 

Business Use Case: The finance department uploads monthly expense dashboards to 
the Service, so that management can review real-time statistics on demand rather than 
needing to wait for emailed reports. 

“Activity 2” 

Instruction to Student: 

Create basic Power BI report in Desktop with sales and expense data. 

Publish the report to Power BI Service. 

Create a workspace, with access for at least one other person (or fake it by granting 
permission roles). 

In order to test this sharing functionality, check if the second user is able to see the 
report. Write a brief reflection on how did it feel to access the report in Desktop vs 
Service. 

6.2.3 Sharing Dashboards and Reports with Stakeholders 

The real value of Power BI is being able to share the insights that you have made with 
decision-makers. 

Methods of Sharing: 
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Direct Sharing - Share report or dashboard to specific colleagues by email. 

Workspaces – Give a team or department access to a set of reports. 

Apps – Bundle dashboards and reports together, and share with more people in your 
organization with an app. 

Embed Options – Ability to embed dashboard into Microsoft Teams or websites. 

Considerations: 

• Permissions: Users can be granted “view-only” or “edit” access. 

• Security: Use RLS to make sure sensitive data (such as salaries or regional sales) is 
available only to those entitled. 

• Accessibility: User reports can be accessed on laptops, tablets or mobile devices. 

Business Example: A CEO has a shared dashboard that aggregates company KPIs. At 
the same time, the regional managers they only see how well their own territory 

performs due to row-level security in the Service. 

 

Knowledge Check 1 

Choose The Correct Options: 

Q1. What Power BI feature will enable a user to drilldown to Year → Quarter → Product? 

Month in a single slicer? 

A) Drill-Through 

B) Hierarchical Slicer 

C) KPI Card 

D) Bookmark 

Q2. Why do they always put the most important KPI on the top left, or center when 
creating a dashboard? 

A) Because this is the way Power BI places it by default 

B) Screen pattern as users naturally scan screens in a Z pattern 

C) For the reasoning that filters can only be applied to visuals at that position 

D) If you move the gfx outside of 32 pixel range they staygreen because bigger gfx go at 
the top. 
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Q3. What is the name of that feature in Power BI Service that alerts a manager when 
sales fall below certain amount? 

A) Scheduled Refresh 

B) Row-Level Security 

C) Data Alerts 

D) Drill-Down 

Q4. A user needs all of the visuals on a dashboard to refresh automatically when a 
region is clicked on a map, which feature can be used to accomplish this? 

A) Drill-Through 

B) Cross-Filtering and Cross-Highlighting 

C) Static Visuals 

D) Remove Filters 

Q5. What's the primary diƯerence between publishing in PBI desktop and Service? 

A) If I'm adding from a Desktop I can view the on mobile not Service, doesn't do that. 

B) Accessibility to collaboration, sharing and scheduled refresh ServiceYes DesktopNo 

C) Desktop = Cloud based, Service = Desktop installed locally 

D) No authentication is required with Service, Desktop does 

6.3 Summary 

Summary  This chapter covered being able to making sense of a dataset by using the 
interactive dashboards and Power BI Service. 

Dynamic, user-driven reports are delivered through interactive dashboards including: 
slicers, filters drill-through and key-performance indicators. 

 Clear and usable principles in dashboard design for business users’ attention to their 
decision-making. 

 Power BI Service, Microsofts cloud-based platform, provides a venue for publishing 
sharing and collaborating on the content developed with Power   

dashboards. 

 Workspaces, apps, scheduled refresh, row-level security Tools such as workspaces 
and apps (coming soon), scheduled refresh (coming soon) and row-level security 
(coming soon) make the Service a must-have for enterprise-level reporting. 
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Sharing dashboards Let the right people have access to the right data, on any device, 
anytime. 

6.4 Key Terms 

Interactive Dashboard: Group of visuals that you can interactively adjust using slicers 
and other filters. 

• Slicer : A Power BI tool that enables users to filter data in a dynamic manner. 

• Drill-Through: A capability that allows users to go from a summarized visual to see 
more with a detailed report page. 

• KPI (Key Performance Indicator): A visual that compares progress to a target. 

• Workspace: Workspaces in Power BI Service are where you have reports and 
dashboards on the grounds that share them find a workable pace. 

• Power BI Service: Microsoft’s cloud service for sharing, publishing and collaborating 
using your Power 

BI reports. 

• Row Level Security (RLS): A way to secure users and show them their own data only. 

• App (in Power BI): A collection of dashboards and reports that you can package up 
and deliver to a broad audience. 

6.5 Descriptive Questions 

What are the main aspects of a good dashboard design, and how do these matter? 

Describe interactivity in a Power BI dashboard, including slicers, filters, and drill 
through functionality. 

DiƯerentiate KPI card with gauge visual. Provide business scenarios for each. 

Explain how to publish a report from Power BI Desktop into Power BI Service. 

What is diƯerence between workspace and share workspace in power bi service for 
collaboration? 

What is RLS and how does it enhance data governance within a dashboard? 

Describe the use of Power BI Service for company-wide reporting and decision-making. 

6.6 References 

• Microsoft Learn: Power BI Documentation. Available at: 
https://learn.microsoft.com/en-us/power- bi 

• Russo, M., & Ferrari, A. (2019). The Definitive Guide to DAX. Microsoft Press. 
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• Power BI Community Blogs: https://community.powerbi.com 

• Enterprise reporting case studies adapted from retail and service industries. 

 

Answers to Knowledge Check 

Correct Options for Knowledge Check 1: 

Q1: B) Hierarchical Slicer 

Q2: B) Because users naturally scan screens in a Z-pattern 

Q3: C) Data Alerts 

Q4: B) Cross-Filtering and Cross-Highlighting 

Q5: B) Service enables collaboration, sharing, and scheduled refresh, Desktop does not 

 

6.7 Case Study 

Case Study: Inbuilt Dashboards and Power BI Service for a Retail Chain Background: 

FreshMart had a chain of supermarkets all over India and used to face weekly Excel 
reporting challenges with limited interactivity and lengthy report preparation time. It was 
a common requirement for regional managers to ask for things like sales by product 
category or store, but it’s something that they generally had to request manually. The 
leadership team required a reporting system that was faster and more dependable. 

Problem Statement 1: Lack of Interactivity in Reports 

Reporting was static and didn’t make it easy to play with data. 

Solution: 

The BI team had created interactive dashboards in Power BI Desktop. Other features, 
such as slicers and drill-through, made it a snap for managers to instantly filter by 
region or product line. KPIs YTD Revenue, Profit Margin and Customer satisfaction all at 
a glance. 

Problem Statement 2: DiƯiculty in Sharing Reports Across Regions 

Managers used emailed attachments of Excel files, which bred version problems. 

Solution: 

I published the dashboards to the Power BI Service. Every manager pulled up the 
reports online, over web or mobile. The data set had scheduled refresh and was 
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current. An environment was set up for each region, with roll-up dashboards sent to 
head oƯice. 

Problem Statement 3: Ensuring Secure Data Access 

The company had to ensure that managers saw only their regional performance, not 
the work of others. 

Solution: 

Row-Level Security (RLS) was implemented. Managers in North Zone had only visibility 
to North Zone data and CEO could see everything across all Zones. It secured safety 

and eƯiciency both. 

Outcome: 

• Managers were able to make decisions more quickly, because they could dig through 
data on their own. 

• Reports were automatically refreshed and always current. 

• Data confidentiality was also secured with RLS. 

• The CEO got a single national dashboard, while managers worked on their rankings. 

MCQ for Learners: 

What Power BI capability doesn't allow a manager to view their colleague's regional data 
in a dashboard but only their own? 

A) Drill-Through 

B) Row-Level Security (RLS) 

C) KPI Cards 

D) Workspaces 

Answer: B) Row-Level Security (RLS) 
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0% detected as AI
The percentage indicates the combined amount of likely AI-generated text as 
well as likely AI-generated text that was also likely AI-paraphrased.

Caution: Review required.

It is essential to understand the limitations of AI detection before making decisions 
about a student’s work. We encourage you to learn more about Turnitin’s AI detection 
capabilities before using the tool.

Detection Groups

0 AI-generated only 0%
Likely AI-generated text from a large-language model.

0 AI-generated text that was AI-paraphrased 0%
Likely AI-generated text that was likely revised using an AI-paraphrase tool 
or word spinner.

Disclaimer
Our AI writing assessment is designed to help educators identify text that might be prepared by a generative AI tool. Our AI writing assessment may not always be accurate (i.e., our AI models 
may produce either false positive results or false negative results), so it should not be used as the sole basis for adverse actions against a student. It takes further scrutiny and human 
judgment in conjunction with an organization's application of its specific academic policies to determine whether any academic misconduct has occurred.

Frequently Asked Questions

How should I interpret Turnitin's AI writing percentage and false positives?
The percentage shown in the AI writing report is the amount of qualifying text within the submission that Turnitin’s AI writing 
detection model determines was either likely AI-generated text from a large-language model or likely AI-generated text that was 
likely revised using an AI paraphrase tool or word spinner.
 
False positives (incorrectly flagging human-written text as AI-generated) are a possibility in AI models.
 
AI detection scores under 20%, which we do not surface in new reports, have a higher likelihood of false positives. To reduce the 
likelihood of misinterpretation, no score or highlights are attributed and are indicated with an asterisk in the report (*%).
 
The AI writing percentage should not be the sole basis to determine whether misconduct has occurred. The reviewer/instructor 
should use the percentage as a means to start a formative conversation with their student and/or use it to examine the submitted 
assignment in accordance with their school's policies.

What does 'qualifying text' mean?
Our model only processes qualifying text in the form of long-form writing. Long-form writing means individual sentences contained in paragraphs that make up a 
longer piece of written work, such as an essay, a dissertation, or an article, etc. Qualifying text that has been determined to be likely AI-generated will be 
highlighted in cyan in the submission, and likely AI-generated and then likely AI-paraphrased will be highlighted purple.
 
Non-qualifying text, such as bullet points, annotated bibliographies, etc., will not be processed and can create disparity between the submission highlights and the 
percentage shown.
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Unit 7: Customer Analytics Project 

 

Project Statement: 

1. Total Number of Unique customers across various regions and Gender 
distribution across each region 

2. Gender distribution in percent among overall number of customers. 

3. Average Balance based on Job Classification 

4. Average balance based on age range 

5. Trend for the number of new customers on boarded each month of 2025 

6. Find the two top most customers based on the sum of the balance they have in 
the account 

7. Prepare the dashboard. 

 

Detailed Instruction Manual: 

Step 1: Understand the Dataset 

You need to obtain the dataset from the LMS. 

Look up the data dictionary (if you have one) or just look at those columns. 

o Commonly used fields: customer_id, gender, region, dob, job_class, onboard_date, 
account_id, balance as_of_date. 

Check for: 

o Missing values. 

o Duplicate rows. 

o Values cannot be misjointed (e.g., “M” vs “Male”). 

Data Cleaning & Preparation 

deduplicate by customer_id and account_id. 

Standardize categorical fields: 

o Gender → “Male”, “Female”, “Other/Unknown”. 

o Region → consistent names. 

Handle missing values: 
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o Change to “Unknown” or delete if irrelevant. 

Calculate Age from dob. 

Create age ranges (bins): 

o 18–24, 25–34, 35–44, 45–54, 55–64, 65+. 

Calculate customer total balance: 

o Totals per customer (balance latest of each account if multiple snapshots). 

Step 3: Analysis & Metrics 

Task 1: Number of Distinct Customers by Region & Sex 

• Count unique customers in total. 

• Group by region. 

• Display gender coverage within each region. 

• Graphic → Stacked or Grouped bar chart. 

Task 2: Mix of Men and Women (Total %) 

• Count customers by gender. 

• Convert counts into percentages. 

• Display → Pie or Doughnut Chart. 

Task 3: Job Classification - Average Balance 

• Group customers by job_class. 

• Average total balances for both groups are computed. 

• Browse → Job classes on X-axis as bar chart. 

Task 4 – Average balance by age-section 

• Use the age bins you carried out above. 

• Calculate average balance for each bin. 

• Visualize → Histogram with Age Bins. 

Task 5: Monthly New Customers for (2025) 

• Extract the customers who onboard_date is in 2025. 

• Count new customers by month. 

• View → Growth per month as a line graph. 
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Task 6: Top 2 Customers in terms of Balance 

• Rank customers by total balance. 

• Select top 2 customers. 

• Show → Table or KPI cards. 

Step 4: Dashboard Creation 

You should now be able to import this cleaned data set in your BI tool (I am using 
PowerBI). 

Generate separate charts for each task (1–6). 

Arrange them on the dashboard: 

• Top row: KPIs (Total Customers, Gender %). 

• Left panel: Filters (Region, Gender, Job Class, Age). 

• Center: Visualizations (bar, line, pie). 

• Bottom: Top 2 customers table. 

Ensure interactivity: 

• Filters should update all visuals. 

• On-hover tooltips should display more info. 

Step 5: Documentation & Reporting 

Write a brief project report (2-3 pages) that includes the following: 

• Introduction (project objective). 

• Data cleaning steps. 

• Analysis & methodology. 

• Key findings from each task. 

• Dashboard snapshots/screenshots. 

• Limitations and recommendations. 

Save the dashboard file (i.e., you are saving the . pbix for Power BI,. twbx for Tableau, or 
Streamlit link). 

Step 6: Submission Checklist 

• Cleaned dataset file. 

• Code/SQL scripts or notebooks used. 
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• Dashboard file or shareable link. 

• Project report (PDF/Word). 
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0% detected as AI
The percentage indicates the combined amount of likely AI-generated text as 
well as likely AI-generated text that was also likely AI-paraphrased.

Caution: Review required.

It is essential to understand the limitations of AI detection before making decisions 
about a student’s work. We encourage you to learn more about Turnitin’s AI detection 
capabilities before using the tool.

Detection Groups

0 AI-generated only 0%
Likely AI-generated text from a large-language model.

0 AI-generated text that was AI-paraphrased 0%
Likely AI-generated text that was likely revised using an AI-paraphrase tool 
or word spinner.

Disclaimer
Our AI writing assessment is designed to help educators identify text that might be prepared by a generative AI tool. Our AI writing assessment may not always be accurate (i.e., our AI models 
may produce either false positive results or false negative results), so it should not be used as the sole basis for adverse actions against a student. It takes further scrutiny and human 
judgment in conjunction with an organization's application of its specific academic policies to determine whether any academic misconduct has occurred.

Frequently Asked Questions

How should I interpret Turnitin's AI writing percentage and false positives?
The percentage shown in the AI writing report is the amount of qualifying text within the submission that Turnitin’s AI writing 
detection model determines was either likely AI-generated text from a large-language model or likely AI-generated text that was 
likely revised using an AI paraphrase tool or word spinner.
 
False positives (incorrectly flagging human-written text as AI-generated) are a possibility in AI models.
 
AI detection scores under 20%, which we do not surface in new reports, have a higher likelihood of false positives. To reduce the 
likelihood of misinterpretation, no score or highlights are attributed and are indicated with an asterisk in the report (*%).
 
The AI writing percentage should not be the sole basis to determine whether misconduct has occurred. The reviewer/instructor 
should use the percentage as a means to start a formative conversation with their student and/or use it to examine the submitted 
assignment in accordance with their school's policies.

What does 'qualifying text' mean?
Our model only processes qualifying text in the form of long-form writing. Long-form writing means individual sentences contained in paragraphs that make up a 
longer piece of written work, such as an essay, a dissertation, or an article, etc. Qualifying text that has been determined to be likely AI-generated will be 
highlighted in cyan in the submission, and likely AI-generated and then likely AI-paraphrased will be highlighted purple.
 
Non-qualifying text, such as bullet points, annotated bibliographies, etc., will not be processed and can create disparity between the submission highlights and the 
percentage shown.
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Unit 8: Aircraft Manufacturing Industry Analytics Project 

 

Project Statement 

1. Region-wise Client Spread (Map Representation), with drill-down popup for 
country in the same map 

2. Average Age of Aircraft = (Today's Date – Manufacturing Date) 

3. Client-wise Security Submitted 

4. Client-wise Revenue along with Forecast 

5. Present KPIs on top in dashboard: 

o Avg. Engine PRSV Rate (for each engine per FH) 

o Avg. Engine LLP Rate (for each engine per FC) 

o Avg. APU Overhaul Rate (per FH) 

o Avg. Landing Gear Overhaul Rate (per month) 

o Avg. Aircraft MTOW (lbs) 

6. Trend for the number of aircrafts getting manufactured each year by each client 

7. Prepare the dashboard 

 

Detailed Instruction Manual 

Step 1: Understand the Dataset 

• get the thing from LMS. 

• Take a look at the data dictionary (if one's been provided) or investigate / experiment 
with the columns yourself. 

Typical fields: 

client_id, region, country, aircraft_id, manufacture_date, engine_prsv_rate, 
engine_llp_rate, apu_overhaul_rate; landing_gear_overhaul_rate,aircraft_mtow and 
flight_hours; flight_cycles; security_submitted and revenue and forecast_revenue 
information will be needed as manufacturing_year. 

Check for: 

• Missing values 
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• Duplicate rows 

• Non-standard values (e.g., country or region names, types of dates). 

Data Cleaning & Preparation - Step 2 

• Distinct by aircraft_id and client_id. 

• Standardize categorical fields: 

o Region and Country naming should remain the same. 

• Handle missing values: 

o Replace 0 with “Unknown” or delete if not important o MENU Drive Type > Edit > 
Options Tab>Action: Delete Key/Value= "DRIVETYP" Key Name= "DRIVETYP". 

• Calculate Aircraft Age: 

o Aircraft Age = TODAY() – manufacture_date 

• Extract Year from manufacture_date 

• Aggregate data as needed: 

o Total revenue per client 

o On average the rates for KPIs for a particular aircraft/engine. 

Step 3: Analysis & Metrics 

Task 1: Country-wide Distribution (with Country Drill-down) 

• Group by Region and Country 

• How many clients are there in [Country] in each of our regions? 

• View → Interactive Map with colour-coded areas and detail up to country level 

Task 2: Age of Aircraft 

• Calculate average aircraft age [TODAY() - manufacture_date] 

• View → KPI Extract or Number Cards 

Task 3: Client-wise Security Submitted 

• Sum security_submitted grouped by client 

• Visualize → Horizontal Bar Chart 

Job 4: Turnover and Forecasts by Customer. 

• Group by client and show: 
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o Actual Revenue 

o Forecast Revenue 

• See → Clustered Bar Chart or Line-Column Combo 

Task 5: KPIs (Top Row on Your Dashboard) 

• Report the following high-level meterics: 

o Avg. Engine PRSV Rate (per FH) 

o Avg. Engine LLP Rate (per FC) 

o Avg. APU Overhaul Rate (per FH) 

o Avg. ROTECTION PATE 77-17 HT 8 ARNING GWEAR OVERHAL RAE (per month) 

o Avg. Aircraft MTOW (lbs) 

• Visualize → KPI Cards 

Task 6: The trend of Aircrafts Made Per Year per Client 

• Group by manufacturing_year and client_id 

• Count number of aircrafts 

• Graphics → Line Chart (Years on X, Count on Y, Color by Client) 

Step 4: Dashboard Creation 

• Load the clean dataset in your BI tool (Power BI / Tableau / Looker Studio / Streamlit). 

• Make separate charts for each of the task (Tasks 1–6). 

• Arrange them on the dashboard: 

Layout Recommendation: 

• Top row: KPIs (Avg. Rates and MTOW) 

• Filters on Left panel (Region, Client, Year) 

• Center: Visualizations 

o Map (Task 1) 

o Revenue, Forecast, and Security Charts 

o Trend line (Task 6) 

• Bottom: Aircraft Age Summary 

Ensure interactivity: 
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• Filters should update all visuals 

• Hover Tooltips should display more information 

• Drill-down enabled (Region → Country) 

Step 5: Documentation & Reporting 

Prepare a brief report (two to three pages) that includes the following information. 

• Introduction (project objective) 

• Data cleaning steps 

• Analysis & methodology 

• Key findings from each task 

• Dashboard snapshots/screenshots 

• Limitations and recommendations 

Save the dashboard as a fil e (i.e., . pbix for Power BI,..twbx for Tableau, or Streamlit 
link). 

Step 6: Submission Checklist 

• Cleaned dataset file 

• Code/SQL scripts or notebooks used 

• Dashboard file or shareable link 

• Project report (PDF/Word) 
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*% detected as AI
AI detection includes the possibility of false positives. Although some text in 
this submission is likely AI generated, scores below the 20% threshold are not 
surfaced because they have a higher likelihood of false positives.

Caution: Review required.

It is essential to understand the limitations of AI detection before making decisions 
about a student’s work. We encourage you to learn more about Turnitin’s AI detection 
capabilities before using the tool.

Disclaimer
Our AI writing assessment is designed to help educators identify text that might be prepared by a generative AI tool. Our AI writing assessment may not always be accurate (i.e., our AI models 
may produce either false positive results or false negative results), so it should not be used as the sole basis for adverse actions against a student. It takes further scrutiny and human 
judgment in conjunction with an organization's application of its specific academic policies to determine whether any academic misconduct has occurred.

Frequently Asked Questions

How should I interpret Turnitin's AI writing percentage and false positives?
The percentage shown in the AI writing report is the amount of qualifying text within the submission that Turnitin’s AI writing 
detection model determines was either likely AI-generated text from a large-language model or likely AI-generated text that was 
likely revised using an AI paraphrase tool or word spinner.
 
False positives (incorrectly flagging human-written text as AI-generated) are a possibility in AI models.
 
AI detection scores under 20%, which we do not surface in new reports, have a higher likelihood of false positives. To reduce the 
likelihood of misinterpretation, no score or highlights are attributed and are indicated with an asterisk in the report (*%).
 
The AI writing percentage should not be the sole basis to determine whether misconduct has occurred. The reviewer/instructor 
should use the percentage as a means to start a formative conversation with their student and/or use it to examine the submitted 
assignment in accordance with their school's policies.

What does 'qualifying text' mean?
Our model only processes qualifying text in the form of long-form writing. Long-form writing means individual sentences contained in paragraphs that make up a 
longer piece of written work, such as an essay, a dissertation, or an article, etc. Qualifying text that has been determined to be likely AI-generated will be 
highlighted in cyan in the submission, and likely AI-generated and then likely AI-paraphrased will be highlighted purple.
 
Non-qualifying text, such as bullet points, annotated bibliographies, etc., will not be processed and can create disparity between the submission highlights and the 
percentage shown.
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Unit 9: Diagnosis Data Insights Project 

 

 

Project Statement 

1. Total number of patient diagnoses done in the dataset 

2. Percentage of patients with a history of Heart Attack 

3. Percentage of patients with a history of Stroke 

4. Count of female patients who are not overweight 

5. Number of patients based on Health Risk 

6. Average weight of people based on Occupation 

7. Total number of overweight patients based on Race 

8. Number of normal health candidates in each age group 

9. Number of patients who smoke and are at HIGH health risk 

10. Number of patients who exercise less than 30 minutes and are at HIGH or 
MODERATE health risk 

11. Prepare the dashboard 

 

Detailed Instruction Manual 

Step 1: Understand the Dataset 

• Download the file from LMS or shared folder. 

• Review the fields provided. Common fields may include: 

o patient_id, gender, age, profession, weight bmi race health_risk smoking_habit 
exercise_mins heart_attack_history stroke_history overweight_flag 

Check for: 

• Missing values 

• Duplicates 

• Other columns not like () those in the analysis (ignore ) 

• Columns with blanks - don't rely upon them 

Step 2: Now we Clean the Data and Prepare it. 
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• Remove duplicates based on patient_id 

• Handle missing values: 

o Dropping or imputing by column relevance 

• Standardize values: 

o Nominalize categorical field values (e.g., "High", "HIGH", "high" = Drive: High) 

o Convert flag values from character to binary or standard form (e.g., “Yes”/“No”→ 1/0) 

• Create derived columns: 

o Age Groups: 

 0–18, 19–30, 31–45, 46–60, 60+ 

o Units of time to describe exercise (e.g., 60 min) 

Step 3: Analysis & Metrics 

Task 1: ALL-P Total Diagnoses by Patients 

• Count total unique patient_id 

• Avoid columns with blank values 

• Visualization → KPI Card or Value Display 

Task 2: Proportion with Heart Attack History 

• Filter where heart_attack_history = Yes 

• Calculate: (Count w/ MI) / (Total # of patients) 

• Picture → Pie Chart or Donut Chart 

Task 3:Percent with Prior Stroke 

• Filter the strokes with stroke_history = Yes 

• Calculate percentage 

• Visualize → Pie Chart 

Task 4 Women patients that are not overweight - Count 

• Filter: gender= Female AND overweight_flag = No 

• Count number of such patients 

• Graph → Categorical Values or KPI 

Task 5: Patients by Health Risk 

Page 4 of 6 - AI Writing Submission Submission ID trn:oid:::3618:127350296

Page 4 of 6 - AI Writing Submission Submission ID trn:oid:::3618:127350296



• Group by health_risk 

• Count patients per category 

• Visualize → Bar Chart 

Task 6: Mean Weight for Occupation 

• Group by occupation 

• Calculate average weight 

• Visualize → Bar Chart (Occupation on X-axis) 

Task 7 Overweight patients by race 

• Filter: overweight_flag = Yes 

• Group by race 

• Count number of overweight patients 

• Look at → Stacked or Clustered Bar Chart 

Project Task 8: Age Specific All Group for Normal Health Subjects 

• Filter: health_risk = Normal 

• Group by age group 

• Count number of patients 

• Visualize → Bar Chart 

Task 9: Risky Health Status Patients Smoking + High 

• Filter (b) : smoking_habit = Yes AND health_risk = High 

• Count such patients 

• Visualize → Numeric summary 

Task 10: >Exercise + Low/Med but not High Risk 

• Filter: exercise_mins < 30 and (health_risk = High or health_risk = Moderate) 

• Count patients 

• View → KPI card or bar segment 

Step 4: Dashboard Creation 

• Connect your BI tool (Power BI / Tableau / Looker Studio / Streamlit) to the cleaned 
dataset. 
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• Make separate diagram for each task (Task 1 to10). 

• Arrange them on the dashboard: 

Suggested Layout: 

• Top: KPIs (Total Patients, % with Heart Attack, % with Stroke, Smoking + High Risk) 

• Left Panel - Filters (Gender, Age Group, Health Risk, Race, Occupation) 

• Main Center: 

o Health Risk, Age Group, Race o Barcharts For these analyses we selected four 
variables for focusing on: • Health risk (high/low) • Age Group (65 and under; 66+) 
•Race(COMBN: Hispanic White Black Other). 

o Donut/Pie charts for percentage visuals 

o Trend or distribution graphics where appropriate 

• Bottom Line: Numbers for working out and weigh-ins 

Ensure interactivity: 

• Filters dynamically update all visuals 

• Hover tooltips for insights 

• Highlight/highlight-on-click actions where needed 

Step 5: Documentation & Reporting 

Write a project report (2–3 pages) that contains: 

• Introduction: Objective of the analysis 

• Data Cleanup: Treatment of NA values and unnecessary columns 

• Analysis Logic: How metrics are defined and filter criteria 

• Sight Explanation: Picture of the dashboard and a short description 

• Key Insights: Breakdown of the insights about patient health 

• Constraints & Suggestions: Data quality concerns or next steps 

Step 6: Submission Checklist 

• Cleaned dataset file 

• Code or SQL/Python notebooks 

• Dashboard file or link 

• Project report (PDF/Word) 
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